Progress OpenEdge Business Process Portal Manager's Guide
Notices

For details, see the following topics:

- Documentation copyright notice

Documentation copyright notice

©2013 Progress Software Corporation and/or its subsidiaries or affiliates. All rights reserved.

These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.
Apama, Business Empowerment, Business Making Progress, Corticon, Corticon (and design), DataDirect (and design), DataDirect Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Empowerment Center, Fathom, Making Software Work Together, OpenEdge, Powered by Progress, PowerTier, Progress, Progress Control Tower, Progress Dynamics, Progress Business Empowerment, Progress Empowerment Center, Progress Empowerment Program, Progress OpenEdge, Progress Profiles, Progress Results, Progress RPM, Progress Software Business Making Progress, Progress Software Developers Network, ProVision, PS Select, RulesCloud, RulesWorld, SequeLink, SpeedScript, Stylus Studio, Technical Empowerment, WebSpeed, Xcalia (and design), and Your Software, Our Technology—Experience the Connection are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries in the U.S. and/or other countries. AccelEvent, Apama Dashboard Studio, Apama Event Manager, Apama Event Modeler, Apama Event Store, Apama Risk Firewall, AppsAlive, AppServer, BusinessEdge, Cache-Forward, DataDirect Cloud, DataDirect Spy, DataDirect SupportLink, Future Proof, High Performance Integration, OpenAccess, ProDataSet, Progress Arcade, Progress ESP Event Manager, Progress ESP Event Modeler, Progress Event Engine, Progress RFID, Progress Responsive Process Management, Progress Software, PSE Pro, SectorAlliance, SeeThinkAct, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries or affiliates in the U.S. and other countries. Java is a registered trademark of Oracle and/or its affiliates. Any other marks contained herein may be trademarks of their respective owners.

See Table of Contents for location of Third party acknowledgements within this documentation.
### Table of Contents

**Preface**
- About this documentation: 9
- User types: 9
- Information on documentation: 10
- Conventions used in this manual: 11
- Product support contact information: 12

**Chapter 1: OpenEdge Business Process Server overview**
- Business Process Server components: 15
- How Business Process Server works: 17
- Business Process Server user types: 18

**Chapter 2: Getting started**
- Logging in to Business Process Portal: 23
- Using themes: 24
- Exploring Business Process Portal: 24
  - Business Process Portal page layout: 25
  - Business Process Portal keyboard shortcuts: 26
- Using filter bars: 27
- Sorting a column: 28
- Grid Search: 29
- Rearranging column order: 30
- Navigating through the list: 30
- Drilling down: 31
- Selecting and clearing rows: 31
- Printing: 32
- Getting support: 32
- Accessing help: 33
- Finding Business Process Server details: 33
- Logging out of Business Process Portal: 33

**Chapter 3: Basic Operations**
- Specifying a Date: 35
- Searching Users: 36
  - Searching Group: 37
Chapter 4: Introducing the Management Module ................................................................. 39

Adjusting your browser cache setting .................................................................................. 39
Logging into the Management Module ................................................................................ 40
Using the BPM Manage API ................................................................................................ 41
Accessing the BPM Manage API ........................................................................................ 41
Reviewing User Access/Permissions .................................................................................... 41
Process-Level permissions ..................................................................................................... 41
Report Permissions ................................................................................................................ 42
Permissions for other management features ........................................................................ 43

Chapter 5: Using Management overview features .............................................................. 45

Viewing Tasks Overview page ............................................................................................... 46
Tasks Overview page .............................................................................................................. 46
Viewing Instances Overview page ........................................................................................ 47
Instances Overview page ........................................................................................................ 48
Checking the Status of an Instance ....................................................................................... 49
Updating Worksteps and Work items .................................................................................. 53
Printing the Flow View in the Process Status Viewer ............................................................ 54
Viewing Instance History ...................................................................................................... 55
Checking the Status of an Application .................................................................................. 55
Using the Heatmap ................................................................................................................. 56
Using the Histogram .............................................................................................................. 59
Modifying Global Dataslots ................................................................................................. 59
Updating Application Information ......................................................................................... 59

Chapter 6: Executing and creating reports ........................................................................... 61

Creating and deploying reports using JasperReport ............................................................ 62
Deploying as a Common Report ............................................................................................ 62
Deploying as an Application Report ..................................................................................... 62
Using a Database other than Business Process Server Connection Pool ......................... 63
Adding JAR files to Jasper compiler class path .................................................................... 63
Setting up Jasper Assistant plugin in Progress Developer Studio for OpenEdge ................ 64
Managing Reports Created Using JasperAssistant ............................................................... 65
Creating and executing reports in Business Process Portal ................................................ 66
About Multiapplication reports ............................................................................................ 67
About external reports .......................................................................................................... 67
Running an existing report ................................................................................................... 68
Creating Application (Query) reports .................................................................................. 68
Creating Multiapplication reports ......................................................................................... 73
Defining Parameters for Application and Multiapplications reports .................................. 74
Report Versioning ............................................................................................................... 76
Creating External reports ..................................................................................................... 76
Preface

For details, see the following topics:

- About this documentation
- User types
- Information on documentation
- Conventions used in this manual
- Product support contact information

About this documentation

This guide is part of the documentation set for Progress OpenEdge Business Process Server.

User types

Progress OpenEdge Business Process Server is a business process management system that can be used by the following types of users:
Responsibilities

<table>
<thead>
<tr>
<th>User type</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager</td>
<td>Responsible for automating business processes in a particular business domain. Business Process Portal’s Management module serves as the primary interface to Business Process Server for the Manager, enabling the manager to monitor, analyze, and control business processes. Also uses the Business Process Modeler for modeling and simulation.</td>
</tr>
<tr>
<td>Application Developer</td>
<td>Responsible for creating customized applications for implementing business processes and developing interfaces associated with tasks. Application developers may work closely with Managers to define the requirements of an application, and determine the business processes.</td>
</tr>
</tbody>
</table>

Information on documentation

This documentation includes information for the entire range of Progress OpenEdge Business Process Server users. In the following table, we recommend the guides that are most relevant to each type of user.

<table>
<thead>
<tr>
<th>If you are the …</th>
<th>Read the …</th>
</tr>
</thead>
</table>
                           | *First Steps Guide*  
                           | *Terminology Guide*                                             |
| Manager                   | *Business Process Portal Manager's Guide*  
                           | *Business Process Portal User’s Guide*  
<pre><code>                       | *Terminology Guide*                                              |
</code></pre>
<table>
<thead>
<tr>
<th>If you are the …</th>
<th>Read the …</th>
</tr>
</thead>
</table>
| Application Developer | Application Developer's Guide  
|                   | BP Server Developer's Guide  
|                   | BPM Events User's Guide  
|                   | Business Process Portal Manager's Guide  
|                   | OpenEdge Getting Started: Developing BPM Applications with Developer Studio  
|                   | Customization Guide  
|                   | Managed Adapters Guide  
|                   | First Steps Guide  
|                   | Terminology Guide  
|                   | Server Administrator's Guide  
|                   | Web services Developer's Guide  
| Business Process Server Administrator | BPM Events User's Guide  
|                                           | Business Process Portal Administrator's Guide  
|                                           | Business Process Portal Manager's Guide  
|                                           | OpenEdge Getting Started: Installation and Configuration Guide  
|                                           | Managed Adapters Guide  
|                                           | Terminology Guide  
|                                           | Server Administrator's Guide  
|                                           | Troubleshooting Guide for Administrators  

For the latest Business Process Server documentation updates, see OpenEdge Product Documentation on PSDN (http://communities.progress.com/pcom/docs/DOC-16074).

## Conventions used in this manual

This document uses the following conventions and terminology notations.

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Indicates titles of command buttons, check boxes, options, lists, dialog boxes, and portal page names.</td>
</tr>
<tr>
<td><em>file path</em></td>
<td>Indicates folder paths and filenames.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Indicates book titles.</td>
</tr>
<tr>
<td>Convention (styles and terms)</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>monospace</td>
<td>Represents code segments or examples.</td>
</tr>
<tr>
<td>backward slash &quot;&quot;</td>
<td>Indicates the path in Windows environment. For UNIX environment, replace with forward slash &quot;/&quot;</td>
</tr>
<tr>
<td>OEBPS_HOME or %OEBPS_HOME%</td>
<td>Represents the installation folder of Business Process Server, C:\Progress\OpenEdge\oebpm\server.</td>
</tr>
<tr>
<td>STUDIO_HOME or %STUDIO_HOME%</td>
<td>Represents the installation folder of OpenEdge BPM components, C:\Progress\OpenEdge\oebpm\studio.</td>
</tr>
<tr>
<td>JBOSS_HOME or %JBOSS_HOME%</td>
<td>Represents the installation folder of JBOSS server, C:\Progress\OpenEdge\oebpm\jboss.</td>
</tr>
</tbody>
</table>

### Product support contact information

If the product documentation does not provide a solution to your specific issue, or if you need clarification on the issue, then contact our Product Support team. You can contact the team through the Internet, telephone, or postal mail, as per the details provided in Table 1 on page 12.

**Table 1: Product Support Contact Information**

<table>
<thead>
<tr>
<th>To contact by</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web site</td>
<td><a href="http://progresslink.progress.com/supportlink">progresslink.progress.com/supportlink</a></td>
</tr>
<tr>
<td></td>
<td>If you are an existing customer, then you can log in to the above site for product support. If you are a first time user, then you need to create an account first.</td>
</tr>
<tr>
<td>Telephone¹</td>
<td>1-781-280-4999 for US, Latin America and Canada</td>
</tr>
<tr>
<td></td>
<td>1-781-280-4543 for the Product Support Fax Line</td>
</tr>
<tr>
<td>Postal Address¹</td>
<td>Progress Software Corporation</td>
</tr>
<tr>
<td></td>
<td>14 Oak Park Drive</td>
</tr>
<tr>
<td></td>
<td>Bedford, MA 01730, USA.</td>
</tr>
</tbody>
</table>

To enable us to quickly answer your questions, please provide the following information:

- Your name, installation site address and the license key for Business Process Server software.
- Your Business Process Server version and build number.
- Your operating system, application server and browser, with version and service pack details, if any.
- Your database management system and version, and information on JVM and JDBC used.

¹ For support telephone numbers and offices in your region, visit the support web site above. This contact information is for customer support only.
Progress Software Corporation is a leading global provider of automated business process management solutions. The company’s product, Progress OpenEdge Business Process Server (henceforth referred to as Business Process Server or BP Server), is a comprehensive business process management platform, which enables companies to quickly transform their business processes into flexible and manageable Web applications, distributed over intranets, extranets, and the Internet.
Business Process Server addresses every stage in the business life cycle: define, integrate, publish, monitor, analyze, improve, and control. By adopting an end-to-end approach, Business Process Server incorporates all the key elements required to meet the ever-changing demands of e-business while ensuring e-business success. By providing integrated management tools, Business Process Server lets you monitor operations proactively, modifying automated processes dynamically based on changing external operations online. An overview of a typical automated business process management solutions is shown in Figure 1 on page 14.

Figure 1: Business Process Server overview
For details, see the following topics:

- Business Process Server components
- How Business Process Server works
- Business Process Server user types

**Business Process Server components**

Business Process Server is a suite of integrated components that enables you to easily build intranet, extranet, and Internet applications and manage your e-business. Business Process Server consists of the following components as in Figure 2 on page 15:

**Figure 2: Business Process Server components**

![Business Process Server components diagram](image-url)
### Table 2: Business Process Server components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Portal Home</td>
<td>The Home module of Business Process Portal is the primary interface for application users, enabling them to interact with Business Process Server applications. Users can complete entries to various tasks and applications, and link to the support infrastructure required to complete these tasks.</td>
</tr>
<tr>
<td>Business Process Portal Management</td>
<td>The Management module enables managers to query, report on, and control processes and resources, visible only to the managers.</td>
</tr>
<tr>
<td>Business Process Portal Administration</td>
<td>The Administration module enables Business Process Server Administrators to modify configuration parameters, manage user or group access control, and install or uninstall Business Process Server applications.</td>
</tr>
<tr>
<td>Web services</td>
<td>This component allows application developers to: publish their applications as Web services, and find and convert other available Web services on the Internet into Business Process Server applications.</td>
</tr>
<tr>
<td>BPM Workflow</td>
<td>This component provides a framework for developing and implementing Web-enabled workflow applications.</td>
</tr>
<tr>
<td>Progress Developer Studio for OpenEdge</td>
<td>This is the primary application development tool for Business Process Server, which provides an Eclipse-based integrated development environment in which users can create BPM projects, processes, Web applications, and rule files.</td>
</tr>
<tr>
<td>Business Process Modeler</td>
<td>This tool is used to design templates for basic business processes, and to run simulations of processes and individual worksteps.</td>
</tr>
<tr>
<td>BP Server</td>
<td>This is a flexible, lightweight, scalable workflow process engine for intranets, extranets, and the Internet.</td>
</tr>
<tr>
<td>BPM Events</td>
<td>This open, event-driven rule engine is used to formulate and enforce policies in business applications.</td>
</tr>
</tbody>
</table>
How Business Process Server works

Figure 3 on page 17 provides an overview of the interaction between Business Process Server components.

Figure 3: How Business Process Server works

The following explanations correspond to the labels shown in Figure 3 on page 17, and describe how the components operate.

1. Progress Developer Studio for OpenEdge and Business Process Modeler provide an integrated development environment (IDE) for Business Process Server, where you can design and publish business processes. The application developer designs a process template (with the ".spt" or ".swt" extension) in the IDE that reflects the business flow and other business process requirements. Business rules for the process template can be defined using the Rule Editor, a BPM Events component that is launched with Progress Developer Studio for OpenEdge.


3. Once the process template is defined, Business Process Server Administrators use the Administration module to install the business process on the BP Server. Administrators can also configure Business Process Server components, manage user or group access control,
and publish Business Process Server applications as Web services. Once installed, users access applications through servlets that pass the requests over an RMI/IIOP connection to the BP Server within an EJB Container.

4. The EJB Container provides a runtime environment that executes and manages Java-based program components that run on the server side of a client/server network. Within the EJB Container are the BP Server and BPM Events server.

5. The BP Server writes events to event tables in the database. Each Business Process uses JDBC to connect to database server as well as store events in the database. Within the BP Server, BPM Process Store uses JDBC to connect to the database server process and retrieve the events deposited by the BP Server process. BPM Process Store interprets the events and populates the process tables. These populated tables are used by Business Process Portal modules.

6. Once the process template is installed as a Business Process Server application, application users can use the Home module to do the following:
   - Access applications
   - Obtain information to perform their tasks
   - Launch the application to start process instances from the BP Server

7. Once the process template is installed as an Business Process Server application, managers can use the Management module (if they have access privileges) to monitor execution of process instances and create reports. Servlets receive requests from managers and pass them onto the BP Server over an RMI/IIOP connection. Managers use the Report Builder to define management reports that retrieve information through JDBC to the database server.

8. BPM Events is a rule-based event or message processing server that loads application rules and executes them against the BP Server and/or external events or messages. This server persists data in the database for recovery and with the help of JDBC connects to the database.

9. Managed Adapters exchange information between Business Process Server applications and external applications by converting Business Process Server-specific protocol to the protocol of an external system such as a database or ERP system. When users add a Managed Adapter to a workstep, they can define complex mapping between Business Process Server dataslots and adapter inputs or outputs of the external application. At runtime when the workstep is executed, the Managed Adapter sets the adapter inputs and configuration, and maps the outputs to the appropriate output dataslots.

10. BPM Workflow is a run-time component that executes the presentation flows. This component provides a Model, View, Controller (MVC) paradigm for developing presentation flow-based applications and executing them in a Web container.

11. Business Process Servers Web services component allows BP Server applications to be published as Web services.


Business Process Server user types

There are four user types within Business Process Server, Application users, Managers, Application developers, Business Process Server administrators.
User types

Each Business Process Server user type is defined below:

- **Application users** — Application Users use Business Process Server applications to coordinate specific business tasks with another department within their company, with another company within their organization, and/or with a business partner in another organization. The Home module in Business Process Portal serves as the primary interface in which Application Users run Business Process Server applications.

- **Managers** — Managers are typically experts in a particular business domain, such as quality assurance or human resources. They might need to work with managers from other groups in automating some of the business procedures that these groups share. The Management module in Business Process Portal serves as the primary Business Process Server interface for business managers to coordinate and integrate business processes, enabling them to exchange information with one other, and to share functionality over such standard communication channels as the Internet or e-mail.

- **Application developers** — Application developers are responsible for analyzing business processes and developing interfaces associated with creating tasks or processes. Application developers are often not domain experts themselves, but work closely with Managers to define business processes and determine the requirements of an application. Application developers use Progress Developer Studio for OpenEdge or Business Process Modeler to define the business process; the resulting process template file is tested, simulated, published, and run as a Business Process Server application.

- **Business Process Server administrators** — Business Process Server administrators are responsible for configuring Business Process Server components, managing user or group profiles and access control, and installing or uninstalling Business Process Server applications. The Administration module in Business Process Portal serves as the primary interface for Business Process Server Administrators to administer applications.

All Business Process Server user types can communicate by using one or more Business Process Server applications. They can also communicate with external applications.
Getting started

Business Process Server provides primary Web-based user interface in the form of Business Process Portal. It is a complete portal through which you can interact with Business Process Server applications.

When you log into Business Process Portal, it displays the Home module tab for all users, irrespective of your user type and your user permissions. As an application user, you can display and modify tasks assigned to you, and manage your preferences. Depending on your user type and permissions, you can view and access other module tabs namely, Management and Administration.

If you have Manager rights, then the Management module is also available to you, where you can query, report, and control processes and resources for users.

If you also have administrative rights, in the Administration module, then you can modify configuration parameters controlling Business Process Server operations, manage components, and install/uninstall applications.

Business Process Portal appears as in Figure 4 on page 22.
Note: Though all modules are shown to you in the figures in this guide, you can view and access only those modules for which you have access rights.

Figure 4: Overview of Business Process Portal

Table 3: Business Process Portal modules

<table>
<thead>
<tr>
<th>Module name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>As an application User, view you tasks and instance.</td>
</tr>
<tr>
<td>Management</td>
<td>As a Manager, control your processes and resources</td>
</tr>
<tr>
<td>Administration</td>
<td>As an Administrator, configure and manage components and users.</td>
</tr>
</tbody>
</table>

This chapter describes how to log into and out of Business Process Portal, the screen layout, and how to explore the Home module’s interface. As the interface is uniform for all modules, this information is helpful for other modules also.
Logging in to Business Process Portal

To access Business Process Portal and use it, you need to log in to it. Your Business Process Server administrator typically adds you as a new Application User, and assigns you a User Name and Password. To log in to Business Process Portal, you need to use this User Name and Password.

**To log in to Business Process Portal:**

1. Start the **Login** page according to your platform:

<table>
<thead>
<tr>
<th>Using . . .</th>
<th>Perform the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2003/XP</td>
<td>From the Start menu, choose <strong>Programs &gt; Progress &gt; OpenEdge &gt; BP Server &gt; BP Servers &gt; Start Business Process Server</strong> if you are using the installation machine (For windows only). Otherwise enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/login.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/login.jsp</a> in your browser.</td>
</tr>
<tr>
<td>UNIX</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

The **Login** page is displayed as shown in **Figure 5** on page 23.

**Figure 5: Business Process Portal Login page**

For details, see the following topics:

- Logging in to Business Process Portal
- Using themes
- Exploring Business Process Portal
- Getting support
- Accessing help
- Finding Business Process Server details
- Logging out of Business Process Portal
Note: If you are using a theme other than the default one, then the screens will look different than shown in this document. For more details, see Using themes on page 24.

2. Type your User Name and Password
3. Click Login.

Business Process Portal displays the Task List page Figure 6 on page 24.

Figure 6: Task list

As a typical Application User, you will have access only to the Home module. Other modules to which you may have access are displayed along with Home, as additional tabs depending on your user type and user permissions.

Tip: You can change your password any time by using Home > Profile.

Using themes

Business Process Server provides five predefined themes for Business Process Portal and for applications in the portal. Your Business Process Server administrator can select one of them. For more details, see Customization Guide.

Exploring Business Process Portal

When you log in to Business Process Portal for the first time, you can see the default Home tab, with the My Task page listing tasks assigned to you.

It is displayed as shown in Figure 7 on page 25.
**Note:** Use the Profile menu to select the language you prefer and use the Preferences menu to select a filter that sets the page's display. After configuring the Home tab, your selections are displayed the next time you log in to Business Process Portal.

---

**Business Process Portal page layout**

The terminology used for a typical Business Process Portal page is explained in Figure 7 on page 25.

**Default home page**

*Figure 7: Default home page*

The following table describes the screen terminology used for Business Process portal.

**Table 4: Business Process Portal page terminology**

<table>
<thead>
<tr>
<th>User interface elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global links</td>
<td>Located at the top right corner of every page such as Support or Help, these links are available at all times during the session. It also displays the welcome message for the user who has logged in.</td>
</tr>
<tr>
<td>Module tabs</td>
<td>For your convenience, features of different modules are grouped in sections. All features of a particular group are located in its own Module tab.</td>
</tr>
<tr>
<td>Module menus</td>
<td>Each tab has a set of specific menus. At the right side, a welcome message is displayed to the user.</td>
</tr>
<tr>
<td>Page name</td>
<td>This shows the current page name.</td>
</tr>
<tr>
<td>Link trail</td>
<td>This shows the pages you navigated through to reach the current page. You can click any link in the link trail and go back to that page. If you click a link in the link trail without first saving contents of the current page, then the data in the current page is not saved.</td>
</tr>
</tbody>
</table>
Your data is displayed in this area. Generally it is displayed in one of the following ways:

- **Form**: This lets you interact with the portal. Typically, forms contain text boxes, checkboxes, and options that help you enter data. Forms can be in read-only or editable mode depending upon the contents and access privileges.

- **List**: This lets you view your data in a tabular format. Typically, lists contain filter bars, search options, and page controls that manage which data is displayed and how it should be displayed.

The commands that help you interact with the data are represented by buttons. Buttons that help you accomplish some task but do not change the data values are typically located below the link trail. The links (for instance, My Collaborative Tasks and Next Available Task) are located above the workspace, on the right side. Buttons that operate on the data (for instance, Complete and Reassign) shown in the current page and change their values, are located below the workspace.

### Business Process Portal keyboard shortcuts

Business Process Portal provides the following keyboard shortcuts to access its various module menus and menu options.

#### Shortcuts

The following table lists the keyboard shortcuts available in Business Process Portal.

<table>
<thead>
<tr>
<th>Module</th>
<th>Keys</th>
<th>Menu / Menu option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>CTRL+SHIFT+T</td>
<td>My Tasks</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+M</td>
<td>My Instances</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+S</td>
<td>Applications</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+D</td>
<td>Dashboard</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+O</td>
<td>Profile</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+F</td>
<td>Preferences &gt; Filters</td>
</tr>
<tr>
<td>Management</td>
<td>CTRL+SHIFT+I</td>
<td>Overview &gt; Instances</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+A</td>
<td>Overview &gt; Applications</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+R</td>
<td>Reports &gt; My Reports</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+N</td>
<td>Instance Manager &gt; Instances</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+K</td>
<td>Instance Manager &gt; Tasks</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+W</td>
<td>Instance Manager &gt; Worksteps</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+C</td>
<td>Balanced Scorecard &gt; Console</td>
</tr>
<tr>
<td>Module</td>
<td>Keys</td>
<td>Menu / Menu option</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Administration</td>
<td>CTRL+SHIFT+V</td>
<td>System &gt; Log Viewer</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+U</td>
<td>User Management &gt; Users</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+G</td>
<td>User Management &gt; Groups</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+Q</td>
<td>User Management &gt; Queues</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+P</td>
<td>User Management &gt; Permissions</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+E</td>
<td>User Management &gt; Delegate Settings</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+L</td>
<td>Applications &gt; BP Server</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+Z</td>
<td>Applications &gt; BPM Workflow</td>
</tr>
</tbody>
</table>

You can customize these shortcuts by adding a new one or changing an existing one as per your requirement. For more details, see the *Customization Guide*.

**Using filter bars**

A filter allows you to reduce clutter and focus on the relevant data by displaying only selected data in the workspace.

**To apply a filter using the Filter bar:**

1. Specify values by either entering text in the provided text boxes or selecting them from the lists *Figure 8* on page 27.
2. Click **Search**.

The combination of these values forms a filter.

*Figure 8: Filter bar*

**Global filters**

Business Process Server now provides global filters for most common filtering conditions. They are:

**Filter names**

- Overdue Tasks
- Tasks Due Today
- Tasks Due This Week
- Tasks Due This Month
- Tasks Due This Quarter
- Tasks Due This Year
• Critical Priority Tasks
• High Priority Tasks

Note: You can select a global filter as your default filter from the Home > Profile menu. Alternately, you can use it as required.

Sorting a column

In the Home module, a downward pointing triangle beside the column header indicates that the listed items can be sorted on that column header.

To sort a column:
1. Click the column to display the sorting options.
   Refer Figure 9 on page 28.

   Figure 9: Sorting options - Task list page

2. Choose the required sorting option.
   • A downward pointing triangle beside the column header indicates that the items are sorted in descending order. To sort them in ascending order, click the column header again.
   • An upward pointing triangle beside the column header indicates that the items are sorted in ascending order.

Note: From the Sorting options, you can choose only the required columns to be displayed and thus you can reduce the screen clutter.

The column sorting operation is performed differently in the Management and Administration modules.

• A column header is underlined only when you move the mouse over the column name.
• In the Management and Administration modules, if a column header is underlined, then you can click it to sort the listed items on that column header.
Grid Search

The Grid Search Text toolbar will allow you to search and highlight the given text in the current page of the grid. And this is enabled for all portal grids.

Grid Toolbar Fields

- Textbox
  You can enter the search text in this field. The search functionality is executed on every change of this textbox, so that it is not required to click search for start the searching process. All the occurrences of the given text are highlighted and the row containing the first occurrence is selected by default. A ‘clear’ button is displayed beside the textbox which enables you to clear the textbox. By default, this textbox supports regular expressions. Therefore, if your search conforms with the regular expression syntax, then Business Process Portal considers it as a regular expression, and searches accordingly.

- Previous Row and Next Row Buttons
  These buttons are enabled only when given text is found in the grid, otherwise they are disabled. These buttons help you to navigate and select one of rows which is highlighted. Tooltips are configured to indicate the use case of these buttons.

- Match Case checkbox
  You can use the ‘Match Case’ checkbox to enable case-sensitive search. By default, this checkbox is unchecked.

- Status Bar
  The ‘Status Bar’ displays the number of occurrences or matches found. The icons ‘status ok’ and ‘error status’ indicate the status of the search.
Rearranging column order

You can change the order in which the columns are displayed as per your requirement.

**To change the order of columns:**

Drag the column header and drop it on the column header which should succeed the selected column.

The new position of the selected column is indicated by two arrows.

Whether a particular position is permissible or not is indicated by green check mark on the selected column.

Refer Figure 12 on page 30.

**Figure 12: Rearranging column order**

![Rearranging column order](image)

**Note:** You can change the order of columns in this way only in the Home module.

Navigating through the list

The paging controls allow you to navigate through pages of the current list. These controls are located immediately above and below the list.

The number of items to be displayed per page is specified by the Business Process Server administrator in the Administration module. For more details, refer to the "Using the Portal Configuration Interface" section of the *Business Process Portal Administrator’s Guide*. If the total number of items cannot be displayed in a page, then the exceeded items are displayed on the subsequent pages.

Refer Figure 13 on page 30.

**Figure 13: Paging control - Task list page**

![Paging control - Task list page](image)

Navigating through the pages in Home Module:

- **First Page** control displays the first page
- **Previous Page** control displays the previous page
- **Next Page** displays the next page
- **Last Page** displays the last page
- You can directly display a particular page by specifying its page number in the **Page** text box and pressing the Enter key.

You can click the **Refresh** control to reload the current page.
The top right corner of the list shows the item numbers displayed on the current page out of the total number of items.

The paging controls in the Management and Administration modules are different.

Refer Figure 14 on page 31.

**Figure 14: Paging control**

In the Management and Administration modules, if the number of pages are 10 or less, then all page numbers up to the last page are displayed below the list.

Navigating through the pages in Management and Administration modules:

- You can click a page number to display the corresponding page.
- If the number of pages is more than 10, then, click **Next** helps to access the set of next 10 pages.
- **<Previous** helps to access the set of previous 10 pages.
- The total at the far right of the paging controls represents the total number of items in the list across all pages.

**Drilling down**

If more information is available about an item in the list, then such an item is displayed with a hyperlink.

You can click the hyperlink to drill down to the next level of data and view details of that item.

Refer Figure 15 on page 31.

**Figure 15: Drilling down**

**Selecting and clearing rows**

**To select and clear rows:**

1. Perform either of the following to select rows:
   - You can select one or more rows of items from the list of items displayed on the current page by clicking their respective checkboxes in the first column.
   - To select all rows in the current page, select the check box in the header row.

Selected rows are indicated by different color.
Refer Figure 16 on page 32.

**Figure 16: Rows**

<table>
<thead>
<tr>
<th>No.</th>
<th>Application</th>
<th>Instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assignment</td>
<td>Assignment (2495)</td>
</tr>
<tr>
<td>2</td>
<td>Assignment</td>
<td>Assignment (2496)</td>
</tr>
<tr>
<td>3</td>
<td>Assignment</td>
<td>Assignment (2497)</td>
</tr>
<tr>
<td>4</td>
<td>Assignment</td>
<td>Assignment (2498)</td>
</tr>
<tr>
<td>5</td>
<td>Assignment</td>
<td>Assignment (2499)</td>
</tr>
<tr>
<td>6</td>
<td>Assignment</td>
<td>Assignment (2500)</td>
</tr>
<tr>
<td>7</td>
<td>Assignment</td>
<td>Assignment (2501)</td>
</tr>
<tr>
<td>8</td>
<td>Assignment</td>
<td>Assignment (2502)</td>
</tr>
<tr>
<td>9</td>
<td>Assignment</td>
<td>Assignment (2503)</td>
</tr>
<tr>
<td>10</td>
<td>Assignment</td>
<td>Assignment (2504)</td>
</tr>
<tr>
<td>11</td>
<td>Assignment</td>
<td>Assignment (2505)</td>
</tr>
<tr>
<td>12</td>
<td>Assignment</td>
<td>Assignment (2506)</td>
</tr>
<tr>
<td>13</td>
<td>Assignment</td>
<td>Assignment (2507)</td>
</tr>
<tr>
<td>14</td>
<td>Assignment</td>
<td>Assignment (2508)</td>
</tr>
<tr>
<td>15</td>
<td>Assignment</td>
<td>Assignment (2509)</td>
</tr>
</tbody>
</table>

2. Perform either of the following to clear rows:
   - To clear a particular row, click its checkbox again.
   - To clear all rows uncheck the header row, all selected rows in the page are cleared.

**Printing**

The Print icon (🖨️) displays the contents of the current page in a printable format. You can use your browser’s print feature to print it.

**Getting support**

If you do not find the solution to your problem in the product documentation, then you can contact the support team.

To contact Progress OpenEdge support team:

1. Click **Support** from the global links.
   - Your default mail tool is launched to send a mail to the support team.
2. Add your query and send the mail.
Accessing help

You can access online help from the global links.

To access online help:
• Click Help from the global links.

The help is launched in a separate browser window.
Business Process Portal provides context-sensitive help, displaying the help topic that is relevant to the current module.

Finding Business Process Server details

You can find out details about the Business Process Server using, About from the global links.

To view Business Process Server details:
• Click About from the Global links.

It displays the following details about Application Server, Database Type, Database Version, Business Process Server Version, and Build number in a pop-up window.

You need this information while contacting our support team.

Logging out of Business Process Portal

You can log out of the Business Process Server using the global links.

To quit Business Process Portal:
• Click Logout on the global links.

Basic Operations

This chapter explains the basic operations you can perform while using Business Process Portal. You can perform some or all of these operations in various Business Process Portal screens. However, all these operations may not be available in each Business Process Portal screen. For details, see the following topics:

- Specifying a Date
- Searching Users

Specifying a Date

You can specify a date by typing it in the various text boxes involving a Date (for example, Due Date, Start Date, End Date) or select using Select Date icon, which is generally located beside the Date text box.

To specify a date using Select Date icon, perform the following:

1. Click the Select Date icon ( ) beside the Date box.

   For a blank Date box, the Select Date window displays the current month’s calendar and by default, highlights today’s date and the current time.
Refer Figure 17 on page 36.

Figure 17:Specifying a Date

2. You can select a date by performing one or more of the following operations from Select Date dialog:

   • To select a date from the displayed month, click the desired date. To select today's date, click Today.
   • To display the calendar for another month, use the single arrows provided above the days of the week. Click the arrow pointing right for the next month, or the arrow pointing left for the previous month. Alternatively, to select any other month, you can click and hold the mouse on either of the arrows and then drag it to the desired month.
   • Similarly, to display the calendar for another year, click the double-arrow pointing right for the next year, or the double-arrow pointing left for the previous year. Alternatively, to select any other year, you can click and hold the mouse on either of the double-arrows and then drag it to the desired year.
   • To change the default time, click the hour and minute boxes in the Time section, to increment the value by 1 unit. Alternatively, to decrement the value, hold down SHIFT and then click the respective boxes. To change the value by multiple units, point to the respective boxes and then drag to the right to increment or to the left to decrement the value.

3. Select time from the Time drop down.

The selected date and time is displayed in the Date box.

Note: By default, the Select Date window displays the calendar with each week starting Sunday. To change this setting to another day of the week, click the day in the calendar header.

Searching Users

You can specify a user by typing it in the various text boxes involving a users (for example, User Name, Reassign, Delegated to) or select using Select User icon, which is generally located beside the User text box.

To search a user using Select user icon, perform the following:

1. Click the Search User icon (🔎) is displayed beside the text box.

   Search Users page is displayed where you can search for the users.
Refer Figure 18 on page 37.

Figure 18: Searching Users

2. You can select a user by performing one or more of the following operations from Select User page.

   - You can search for the users by specifying either the user name, or the first name or the last name. If you specify the group name, then it searches for the users in that group, otherwise it searches in all groups.
   - After typing the user name, first name, last name, and optionally, group, click Go. You can also use the * as a wild card. Type in the first letter and then the asterisk (example, a*) and all users beginning with that letter will display. It also works for portions of names; e.g., type in *son and all names ending in son (Jackson, Peterson, etc.) is displayed. Type Mc*son and users such as McPherson and Mcwilliamson is displayed.

Business Process Portal lists all the users satisfying your search criteria. You can navigate through this list as explained in the Getting started on page 21

   - To go directly to the list of users starting with a particular letter, click that letter in the Quick Search bar.

3. Depending on the page and current operation, Business Process Portal allows you to select one or more users. Select users by clicking the options in the first column of those users, and then click Add.

   The selected users’ user names are entered in the User Name text box.

   **Note:** Depending on the page and current operation, the Save and Create New button may also be available. Click this button to add the current user and continue adding more users.

Searching Group

Searching for a group is similar to searching for a user. While searching for a group, you need to specify the group name in the Group Name box by typing it. Alternatively, use the Search Bar to locate the specific group by performing a procedure similar to the one explained above for searching the users.
Introducing the Management Module

This chapter describes the new features introduced in Business Process Server 11.3, introduces you to the Management module of Business Process Portal, and presents an overview of the Management user interface.

Before logging into the Management module, adjust your browser’s cache settings and optionally, customize the date format. For more information, see Adjusting your browser cache setting on page 39 and “Chapter 2, Customizing Properties Files” in the Customization Guide.

You can then:

• Open the Management module by Logging into the Management Module on page 40.
• Learn about controlling access to Management features by Reviewing User Access/Permissions on page 41.

For details, see the following topics:

• Adjusting your browser cache setting
• Logging into the Management Module
• Using the BPM Manage API
• Reviewing User Access/Permissions

Adjusting your browser cache setting

To ensure that you are always viewing up-to-date information, you must set the cache parameter for your browser appropriately to check newer versions of stored pages every time you visit a page. For more details, refer to your browser’s documentation.
You also need to install the Sun JDK version 1.5.0.10 or later, and set it as the virtual machine of your browser. For more details about downloading and installing it, refer to Sun Microsystems’ site and documentation.

Logging into the Management Module

You can log into the Management module through the Business Process Portal, the single sign-on portal for Business Process Server. You need to log in only once to gain access to any other Business Process Server modules for which you have been granted permissions. These modules can include Management, Home and Administration.

**Note:** If you are using Internet Explorer 6.0 SP1, then ensure that you have the Microsoft Virtual Machine installed. To verify this, select Tools > Internet Options, and open the Advanced tab. Under the "Microsoft VM" heading, make sure the "JIT compiler for virtual machine enabled (requires restart)" checkbox is selected.

After starting the servers, you can log into Business Process Portal. For more details, see Logging in to Business Process Portal on page 23.

Click the Management tab to access the Management module. Business Process Server automatically authenticates your user name and password and displays the Instances Overview page.

**Note:** Business Process Server’s Access Control Management feature displays an error message when you were not granted permission to use this resource.

To access features in the Management module, use appropriate module menus. This module contains the following menus:

- **Overview.** Provides an overview of processes in all states, as shown in Using Management overview features on page 45.

- **Reports.** Displays available reports and provides the interface to define and create reports. For more information, see Executing and creating reports on page 61.

- **Instance Manager.** Allows you to efficiently manage large numbers of process instances, worksteps and tasks, and to perform tasks in batches rather than singly. For more information, see Using the Instance Manager on page 91.

- **Balanced Scorecard.** Enables you to determine how your organization's business activities are helping it meet its strategic goals. For more information, see Using the Balanced Scorecard on page 105.

- **Infopad Manager.** Enables you to update the information provided in an infopad, a table that stores such global data as application parameters or rule parameters. For more information, see Using the Infopad Manager on page 119.

To access other Business Process Server modules that are available to you, click a module tab to display a range of menus under that tab. Open a menu and select a submenu item to open the feature.

Once you log in to the Business Process Portal, no further authentication is required when you open a new module.
Using the BPM Manage API

The BPM Manage API, a public API that provides Management module users with access to data that was previously internal, facilitates the customization of Management features. Business Process Server application developers and customizers no longer need to resort to workarounds and reverse-engineering to create the customized pages that they require – the BPM Manage API now exposes the elements needed to modify the Management module to users’ specifications.

The BPM Manage API also uses HTML templates for each type of element, allowing for different levels of customization within the interface pages for each building block. The API can access the lowest-level types of data available and utilized by the Management module, which prevents one of the primary causes for the workarounds that were necessary for customization in the past. While recognizing the need for low-level support, the BPM Manage API also offers higher-level support that includes packaged data and more complex renderings.

Finally, the BPM Manage API provides a set of features that enables Business Process Portal modules to share a single login command.

Accessing the BPM Manage API

The BPM Manage API is implemented as a bean, enabling the user to easily access the API from within all necessary types of applications.

To simplify code and make customization easier, the Management module provides elemental data, i.e., commonly used data that generally is formatted for use within JSPs and/or for display within servlets.

Reviewing User Access/Permissions

The Access Control Manager (ACManager) provides more comprehensive and finer-grained security for Application users. The Business Process Server administrator can determine the access level a Manager has to a specific application and what permissions the user has: for example, can the Manager access a specific process instance; or can the Management module user perform any action on a BPM SQL report. Although the results of this ACManager feature is seen in the Management module, it is defined by Business Process Server Administrators through the Administration module. If, as a Manager, you want to allow or prohibit certain user’s access to specific applications and/or grant or revoke specific permissions to a user, then contact your Business Process Server administrator. See the Business Process Portal administrator’s Guide for additional information.

Process-Level permissions

To better understand how ACManager access/permissions work with Management features, consider the following points involving permissions for process templates, process instances and process dataslots:

• To view and/or update a process template, a Business Process Server administrator must assign you the corresponding rights. The view action enables you to see the item; the update
action enables you to revise it. If you have not been assigned view and/or update permissions for a process template, then it will not appear in the Management module.

- To view and/or update a specific process instance, a Business Process Server administrator must assign you the corresponding rights. You can also be assigned view/update permissions for all process instances.

- To view and/or update a specific process dataslot, a Business Process Server administrator must assign you the corresponding rights. You can also be assigned view/update permissions for all process dataslots.

- To view/update a process dataslot, you must be granted the associated permissions; i.e., to access a process dataslot, you must have the process instance permission and the process template permission.

## Report Permissions

The Business Process Server administrator must assign you the permission to perform any action on the specific report type. In Business Process Server, there are four types of reports: Query Report, MultiApps, External and Infopad Report.

The Business Process Server administrator must first grant you the permission for the application(s) from which the report is derived.

### To view/execute existing Management reports:

1. Once you have the required permissions, the Go button in the My Reports page is enabled and you can execute an existing report (see Running an existing report on page 68).

   **Note:** The report may be filtered, since any process instance or dataslot that the user does not have permissions for is not shown.

2. To create a report, you must have permission for the application(s) the report is derived from and have the Create a Report permission for the application. Once these permissions are granted, the Query button in the My Reports page is enabled and you can create a report (see Creating Application (Query) reports on page 68).

3. To delete a report, you need the permissions described in step 4, as well as the Remove a Report permission. With these permissions, the Delete button in the My Reports page is enabled and you can delete a report (see Removing an Existing report on page 83).

4. To modify an existing report, you need the permissions described in step 4, as well as the Modify a Report permission. With these permissions, Edit Report (edit) icon is available beside the Report Name column in the My Reports page and you can modify an existing report using the Edit Report icon (see Modifying an existing report on page 82).

To hold ReportBuilder permissions, the Business Process Server administrator must assign you the permission to perform any action on any ReportBuilder, as well as permissions for the application(s) from which the report is derived.

To view/update BPM SQL reports, you can execute it by providing default report and default report builder as additional permissions (for more information, see About external reports on page 67).
Permissions for other management features

To hold permission to view and/or update Infopads, the Business Process Server administrator must assign you the view and/or update permissions for a selected infopad.

**Note:** Remember that you must verify that top-level permissions (for example, to an application) have been assigned in order for lower-level permissions (for example, updating a report) are working.

**Note:** Remember that when any applications are installed in Business Process Server to which you have been granted permission as a Manager, you must log out, then log in again, to ensure that this permission is reflected in Business Process Server.
Using Management overview features

The Management module of the Business Process Portal is organized into a series of Web pages utilizing applets to enable you to quickly and efficiently manage Business Process Server applications. This chapter describes procedures that enable you, as a Manager, to monitor and update Business Process Server applications and process instances by performing the following functions:

• Viewing the details of all the tasks, by displaying all instances for all applications, and for all worksteps of all states, or using the filtering functions to view the status of specific tasks for a selected application.

• **Checking the Status of an Instance** on page 49, by displaying all instances for all applications, or using the filtering functions to view the status of specific instances for a selected application. You can also dynamically update the worksteps and work items of an instance, and print the current status of the instances.

• **Updating Worksteps and Work items** on page 53, dynamically modifying an active or suspended workstep or work item without leaving the Management module.

• **Checking the Status of an Application** on page 55, by selecting an application and reviewing its status. You can also view and update its global dataslots, as well as modify and send workstep instructions to other users of the selected application.

**Note:** See Introducing the Management Module on page 39 for an introduction to the Management interface. See Executing and creating reports on page 61 for detailed information about using the Reports function to define and execute reports.
For details, see the following topics:

- Viewing Tasks Overview page
- Viewing Instances Overview page
- Viewing Instance History
- Checking the Status of an Application

## Viewing Tasks Overview page

To view the Tasks Overview page, in the Management module, click **Overview > Tasks**. The Tasks page indicates the status of the tasks.

## Tasks Overview page

The Tasks Overview page displays information about all the tasks. By default, it displays tasks of all users with any state and any priority, and the following information about each task:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>A unique identifier for the application instance. (Only if &quot;All&quot; applications are selected in the filter.)</td>
</tr>
<tr>
<td>Instance</td>
<td>The name of the process instance.</td>
</tr>
<tr>
<td>Instance Status</td>
<td>The status of the filtered instance. (Only when the Process Instance Status filter is set to &quot;All&quot;.)</td>
</tr>
<tr>
<td>Details</td>
<td>Click the PSV Tabular View icon in this column to display the tabular view of the process instance. Click the PSV Flow View icon in this column to display the process instance flowchart at the point of the active task. Click the Audit History icon in this column to display the audit history of the process instance.</td>
</tr>
<tr>
<td>Task</td>
<td>The name of the task.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the task. (Only when Workstep Status filter is set to &quot;All&quot;.)</td>
</tr>
<tr>
<td>Performer</td>
<td>The name of the performer of the task.</td>
</tr>
<tr>
<td>Task Priority</td>
<td>The priority of the task.</td>
</tr>
<tr>
<td>Assigned Date</td>
<td>The date when this task is assigned to the performer.</td>
</tr>
<tr>
<td>Due Date / End Date</td>
<td>The date when the task is due or is to be completed.</td>
</tr>
</tbody>
</table>

These columns are sortable; that means, you can sort the contents of this page based on this column header. For more information, see **Sorting a column** on page 28. This helps to quickly locate tasks(s) based on the application specific dataslot values.

**Note:** Specify the date format for the reports using the DateFormat parameter in `bpmportal.properties`. See "Chapter 2, Customizing Properties Files" in the *Customization*.
Guide for more information about the date format syntax. Business Process Server displays a warning message when you specify an invalid format for a Date field.

To manage the contents of the list, you can filter and/or sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 24.

The Tasks Overview page enables you to:

- Use the Filter bar to search through all applications, or a selected application, for specific tasks.
- See the dataslot values of a particular instance.
- Open the Tabular View to see the properties of each workstep displayed in a tabular format that presents data in a unified view.
- Open the Flow View to see the process flow (i.e., the flow of work from one workstep to the next). From the Flow View, you can also see the instance’s information flow (i.e., the flow of data from one workstep to the next), as shown in the Dataslots View.
- Open the Audit History to view the audit history information of the process instance, as described in Viewing Instance History on page 55.
- View the Task Details page of a task that is not yet completed.
- Send a mail to the performer of a task.

The Tasks Overview page can also be viewed by clicking a workstep in the Heatmap. When you click a workstep in the Heatmap, it sets the search options based on the clicked workstep, and displays the tasks.

**Viewing Instances Overview page**

To view the Instances Overview page, in the Management module, click Overview > Instances. This page indicates the status of the application instances.

**Figure 19: Instances Overview Page**

Use Attributes or Instance Id to search for specific instances.

Instances that meet the filter criteria shown in the workspace.

Click a FSV Flow View icon to open the Process Status Viewer and see a flow chart for the process.
In the Instances Overview page, you can search for a specific instance.

To search for a specific instance:

1. Select search based on **Instance Id**. The Instance Id text box is available.
2. Provide the instance id and then click **Search**.

The instance with that particular instance id is displayed. If it is a not valid instance id, then No records found message is displayed.

**Instances Overview page**

The **Instances Overview** page displays information about the application instances you are currently using. By default, it displays all instances and the following information about each instance:

**Table 7: Instance Overview Information**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>Select this option to search based on any attribute.</td>
</tr>
<tr>
<td>Instance Id</td>
<td>Select this option to search based on a specific attribute.</td>
</tr>
<tr>
<td>Application</td>
<td>A unique identifier for the application instance.</td>
</tr>
<tr>
<td>Instance</td>
<td>The name of the process instance.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the filtered instance.</td>
</tr>
<tr>
<td>Creator</td>
<td>The name of the user who created the instance.</td>
</tr>
<tr>
<td>Details</td>
<td>Click the PSV Tabular View icon in this column to display the tabular view of the process instance. Click the PSV Flow View icon in this column to display the process instance flowchart at the point of the active task. (See Step Table 8 on page 51 for color coding) Click the Audit History icon in this column to display the audit history of the process instance.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority level as determined by the user initiating the process instance. It can be Low, Medium, High, or Critical.</td>
</tr>
<tr>
<td>Estimated Duration</td>
<td>Estimated duration to complete the process instance as determined by the application developer.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date the process instance was initiated.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date by when the process instance should be completed as determined by the application developer.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date on which the process instance was completed.</td>
</tr>
</tbody>
</table>

In addition to the default columns, you can add dataslots as columns using the **New Dataslot** dialog box in the Progress Developer Studio for OpenEdge. For more information, see *OpenEdge Getting Started: Developing BPM Applications with Developer Studio*. These dataslot columns are sortable; that means, you can sort the contents of this page based on this column header. For more information, see *Sorting a column* on page 28. This helps to quickly locate instance(s) based on the application specific dataslot values.

**Note:** Specify the date format for the reports using the **DateFormat** parameter in `bpmportal.properties`. See "Chapter 2, Customizing Properties Files" in the *Customization*
To manage the contents of the list, you can filter and/or sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 24.

The Instances Overview page enables you to:

- Search based on Attributes or Instance Id.
- Search for a specific instance by providing the Instance Id.
- Use the attributes Filter bar to search through all applications, or a selected application, for specific process instances.
- Check the status of the specified process instances.
- Open the Tabular View to see the properties of each workstep displayed in a tabular format that presents data in a unified view.
- Open the Flow View to see the process flow (i.e., the flow of work from one workstep to the next). From the Flow View, you can also see the instance’s information flow (i.e., the flow of data from one workstep to the next), as shown in the Dataslots View.
- Open the Audit History to view the audit history information of the process instance, as described in Viewing Instance History on page 55.

Note: This page is also the Management module’s default page, and the user can return to this page at any time by clicking the Management tab in the Business Process Portal.

Checking the Status of an Instance

To check the status of an instance, complete the following steps:

1. In the Management module, click Overview > Instances, to view the Instances Overview page. Refer Figure 19 on page 47.

2. Use the search features in the Filter bar to specify the process instances you want to monitor.
   a) Select a Business Process Server application from the Applications drop-down list in the upper left of the Filter bar. Data on all instances for the selected application (or for all applications, when you choose All) are displayed in the workspace.
   b) Select an option from the Status drop-down list. Options include: All, Active, Completed, Removed or Suspended. Active indicates the instance is active and can be run. Suspended indicates the instance is temporarily stopped until the Resume option is selected.
   c) Select an option from the Duration drop-down list. Options include: Hours, Weeks, Days, Business Days. Use this search criteria only for instances with a Completed status.
   d) Specify a Creator, if applicable. Click the Edit Creator icon ( ) to open the User List, from which you can select a valid Application user.
e) Select an option from the **Priority** drop-down list. Options include: All, Critical, High, Medium and Low.

f) Select an option from the **Date** drop-down list. Options include: Today | Yesterday, This Week | Last Week, This Month | Last Month, et al. To define a more specific time range, click the Select Date icon (📅) and choose a start date and end date from the pop-up calendars.

**Note:** Instances can be filtered based on the Instance Start Date by specifying the start date from the Start Date drop-down list.

3. After you have finished entering filtering criteria, click **Search** to locate the specified instance(s). Business Process Server displays all the instances satisfying your filter criteria in the workspace. See Table 7 on page 48.

**Note:** Specify the date format for the reports using the DateFormat parameter in `bpmportal.properties`. See "Chapter 2, Customizing Properties Files" in the *Customization Guide* for more information about the date format syntax. Business Process Server displays a warning message when you specify an invalid format for a **Date** field.

4. Click the **PSV Tabular View** icon in the Details column to view the properties of each workstep displayed in a tabular format that presents data in a unified view.

The Tabular View displays the Start workstep as the first workstep at the top of the list. It is followed by the remaining worksteps in the order of their completion and the End workstep is displayed as the last workstep. The same color coding described in Step Table 8 on page 51 is also used in the Tabular View.

Refer Figure 20 on page 50.

**Figure 20: Tabular View**

When you are in the Tabular View, you can:

- Update an Active workstep by modifying its Priority or by changing its Status; for example, suspend, complete and update.
- Update a work item by changing the Performer or selecting an Action. For Reassign, Complete, Make Available and Remove.
• Send an e-mail to the performer(s) by clicking the Performer link. Business Process Server launches your default mail client and enters the e-mail addresses of the performer(s). If there are multiple performers comprising any combination of, list of users and list of groups, then Business Process Server enters individual e-mail addresses of those users and group members. However, if a group contains users and another group, then Business Process Server enters e-mail addresses of only the users but does not enter e-mail addresses of the nested group’s members.
• Expand all Worksteps to show their work items in a printer-friendly version of Tabular View.
• Printing the Tabular view.

5. Click the PSV Flow View icon (\[icon\]) in the Details column to open the Flow View, where you can view the instance in a flowchart.

Refer Figure 21 on page 51.

Figure 21: Flow View

The worksteps color coding is explained in Step Table 8 on page 51.

Table 8: Workstep Color Coding

<table>
<thead>
<tr>
<th>Workstep Color...</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange</td>
<td>Activated workstep</td>
</tr>
<tr>
<td>Green</td>
<td>Completed workstep</td>
</tr>
<tr>
<td>Gray</td>
<td>Inactive workstep</td>
</tr>
<tr>
<td>Blue</td>
<td>Skipped workstep</td>
</tr>
<tr>
<td>Red</td>
<td>Suspended workstep</td>
</tr>
<tr>
<td>Dark Green</td>
<td>Monitoring workstep in wait state.</td>
</tr>
</tbody>
</table>

The Event Playback in the PSV link bar helps you to view the events in the order in which they have occurred. Refer "Using Event Playback" section in Business Process Portal User’s Guide for more information.
6. To access dataslot information for the process instance from the Tabular or Flow View, click View Dataslots to open the View Dataslots page. This page appears if you are granted Dataslot permissions.

**Figure 22: View Dataslots Page**

If you have only View permission for the Dataslot resource, then the fields in the View Dataslots page are read-only. If you have View and Update permissions for the Dataslot resource, then the fields are editable, as shown above.

To change the dataslot information for the process instance:

a) Modify the priority of the instance by selecting an option in the Priority drop-down list.

b) Modify the status of the instance by selecting from the options in the Status drop-down list.

c) Modify the remaining dataslots as needed, and click Save at the bottom of the form. Business Process Server updates the dataslots after your confirmation. To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

7. To access the history of all the transactions of the process instance from the Tabular or Flow View, click Audit History to open the Audit History page. For more information about audit history, refer to Viewing Instance History on page 55.
Updating Worksteps and Work items

You can dynamically update worksteps and work items in the Management module by performing the following procedure:

1. From the Flow View page, click any completed (green), active (orange) or suspended (red) workstep from the flowchart to open the Workstep Details window.

2. The Workstep Details window for a completed workstep displays read-only data that cannot be modified.

Figure 23: Workstep Details Window for a Completed Workstep

<table>
<thead>
<tr>
<th>Workstep Details - DoTask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td><strong>Workstep:</strong> Perform Task</td>
</tr>
<tr>
<td>Start Date: Nov 24, 2008 01:44 AM</td>
</tr>
<tr>
<td>End Date: Nov 24, 2008 01:12 AM</td>
</tr>
<tr>
<td>Estimated Duration: 0 day(s)</td>
</tr>
<tr>
<td>Performer: etms</td>
</tr>
<tr>
<td>Priority: High</td>
</tr>
<tr>
<td>Status: Completed</td>
</tr>
</tbody>
</table>

Active or suspended worksteps display a dialog window with editable fields, where you can update certain workstep and work item properties.

The following figure presents the Workstep Details window for an active workstep.

3. To send an e-mail to the performer(s), click the Performer link. Business Process Server launches your default mail client and enters the e-mail addresses of the performer(s). If there are multiple performers comprising any combination of, list of users and list of groups, then Business Process Server enters individual e-mail addresses of those users and group members. However, if a group contains users and another group, then Business Process Server enters e-mail addresses of only the users but does not enter e-mail addresses of the nested group’s members.

Figure 24: Workstep Details Window for an Active Workstep

<table>
<thead>
<tr>
<th>Workstep Details - Review Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td><strong>Workstep:</strong> Review Task</td>
</tr>
<tr>
<td>Start Date: Nov 24, 2008 04:12 AM</td>
</tr>
<tr>
<td>Estimated Duration: 0 day(s)</td>
</tr>
<tr>
<td>Performer: etms</td>
</tr>
<tr>
<td>Priority: High</td>
</tr>
<tr>
<td>Status: Activated</td>
</tr>
</tbody>
</table>

4. To dynamically modify an active or suspended workstep or a work item during run-time:
   a) In the Workstep Details section, select an option from the Priority drop-down list to update
      the workstep’s priority.
   b) In the Work item(s) section, update information about the Performer by entering data in the
      Performer box or by clicking 🖥️ to open the User List page, where you can select a valid
      user from the list of Application users.
   c) In the Work item(s) section, update Action information by selecting an option from the
      drop-down list in the Action column.
   d) If you want to suspend the workstep, then click Suspend Workstep. The SuspendWorkstep
      option changes the workstep color to red, and temporarily stops the process at the suspended
      workstep until the issue causing the suspension is resolved or you resume workstep
      execution.
   e) If you want to complete the workstep, then click Complete Workstep. The CompleteWorkstep
      option changes the workstep color to green. Business Process Server
      takes a while to mark the workstep as completed and change its color. Therefore, you may
      must refresh the page more than once to reflect the color change.
   f) If the Completed workstep has been designated as a Rollback Point (i.e., it is the workstep
      from which the workflow is restarted when a process fails during execution), then a Rollback
      button is displayed in the Workstep Details window. Select Rollback to “roll back" the
      process to the rollback point.
   g) The Dataslots section displays a list of dataslots used for the selected workstep. If you have
      permissions to update the dataslots, then you can update individual dataslot values.
   h) The Audit History section displays the audit history details of the selected workstep.

5. Click Save to save any changes you made in the Workstep Details page. Business Process
   Server automatically reloads the Flow View.
   Click Reset to clear any data you entered and return to the original settings. Click Cancel to
   delete any updates, and return to the Flow View page.

   **Note:** Completed worksteps and work items cannot be modified. Removed instances also
   cannot be modified.

### Printing the Flow View in the Process Status Viewer

**To print the Flow View:**

1. Use the Zoom in and Zoom out icons to specify the size for the Flow View. Business Process
   Portal prints the Flow View using the zoom level you have selected.

   **Note:** You can use the zoom feature to print the entire Flow View in a single page. This can
   be used for the Flow View and Heatmap.

2. Click the Print icon ( 🖨️) to open the Print dialog box.
   Refer Figure 21 on page 51.

3. Specify the appropriate settings, and click Print to directly print the current Flow View. The
   Flow View is printed with a page title and page number.

   **Note:** You can also print the flow view as a PDF by selecting Adobe PDF in your settings.
Viewing Instance History

Business Process Server maintains a complete transactional audit of a process instance, in the form of events in the database. These events capture changes in the process instance status, as well as dataslots. You can view these instance history details from the Audit History page. To view the audit instance history, from the Instances Overview page Figure 19 on page 47, click the Audit History icon for the process instance, whose information is to be viewed. Alternatively, click the Audit History link from the Tabular View or Flow View of a process instance. The Audit History page is displayed, comprising of the Header section and the Details section. This page and the procedures you can follow using this page are identical to the Audit History page you can access in the Home module. For more information, see “Chapter 7, Working with My Instances” in the Business Process Portal User’s Guide. In the Audit History page, the values for the Completed on, Total duration and Elapsed time fields can be seen only by the user with managerial privileges when all tasks of that process instance are completed.

Checking the Status of an Application

To view the Application Overview page, in the Management module, click Overview > Applications. The Application Overview page enables you to:

• Check the status of one or more selected applications.
• See the heatmap view of an application, which gives overview of active, suspended and completed instances of the application.
• See the tabular view which enables you to view and update workstep-level instructions for worksteps of a selected application.
• See the information flow at the application level, by opening the Global Dataslots view.
• Add or modify application-level information such as, instructions, and URL links.

To check the status of an application, complete the following steps:

1. In the Management module, click Overview > Applications. The Application Overview page is displayed.

2. Select a Business Process Server application and/or select a status from the Applications and Status drop-down list respectively, and click Go. The Application Overview page is displayed. This page displays information about the applications satisfying your filtering criteria. By default, it displays all applications and the following information about each one of them:

<table>
<thead>
<tr>
<th>Table 9: Application Overview Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Status</td>
</tr>
</tbody>
</table>
To navigate through the pages, you can use the paging controls. For more details about this operation, see Exploring Business Process Portal on page 24.

3. Click the Tabular icon in the Tabular column to view each workstep for a selected application displayed in a tabular format. Here, you can enter new, or modify existing, instructions for each workstep.

4. Click the Flow icon in the Flow column to view a workflow chart of the selected application in the workspace. Click a workstep to open the Tasks Overview window.

For more details, refer to Viewing Tasks Overview page on page 46.

5. To change from the Tabular view, click the Flow View link to view the Flow View. Similarly, to change from the Flow view, click the Tabular View link to view each workstep for a selected application displayed in a tabular format. Here, you can enter new, or modify existing, instructions for each workstep.

6. Click Save to save any changes you made in the Workstep Instructions window or in the Tabular View page. Click Reset to clear any data you entered and return to the original settings. Click Cancel to delete any updates, and return to the previous page.

### Using the Heatmap

When you click the Flow icon for a process in the Application Overview page, a color-coded Flow View or Heatmap is displayed.

A heatmap helps a Manager to:

- Get an overview of the status of the currently active instances. Using this as a tool a business manager can identify potential bottlenecks in the process.
- Identify worksteps that have been suspended, for a variety of reasons and take necessary actions to resume the suspended processes.
- Analyze the history of the completed instances to identify potential trends and opportunities for optimization.

In the Flow View, you can use the Process Instance Status drop-down list to filter the instances and Workstep Status drop-down list to filter the worksteps in the heatmap based on their status. You can select Completed from the PI Status, select Activated, Suspended or Completed or Monitoring wait from the Workstep Status, and then click Go, or select Activated from the PI Status, select Activated, Suspended or Completed from the Workstep Status, and then click Go. The heatmap graphically shows the status of all worksteps for the specified status of process instances. For example, if you select Activated from the PI Status drop-down list, Suspended from the Workstep Status drop-down list and click Go, then the heatmap displays all suspended worksteps of all the active process instances. When you change the Process Instance Status option, it automatically updates the options in the Workstep Status drop-down list. However, to refresh the heatmap, you need to select the PI Status option, select Workstep Status option, and then click Go.

Each workstep is color-coded as described in the following table.
Table 10: Heatmap Color Coding

<table>
<thead>
<tr>
<th>Color Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red to Green</td>
<td>For values between the maximum and the median.²</td>
</tr>
<tr>
<td>Green to Blue</td>
<td>For values between the median and the minimum.</td>
</tr>
</tbody>
</table>

The legend in a heatmap does not display all the bin colors. It displays only the colors that are used in that heatmap.

The number in the parenthesis after the activity label indicates the total number of workstep instances of the specified status.

A bottleneck can be identified by a red workstep immediately followed by one or more green worksteps.

Refer Figure 25 on page 57.

**Figure 25: Heatmap of a Bottleneck**

Heatmap Algorithm

Heatmap works based on the values of total instances of the application for the given process instance status and total instances that executed each workstep for the given activity status.

The heatmap algorithm uses nine different bins to uniformly distribute the process instance count of the selected application into them. Each bin in the heatmap has an associated fill color as shown in the following figure. Bin number starts from zero.

The following figure displays the bin number or bin index in each bin.

**Figure 26: Bin Colors in Heatmap**

² Median is calculated by adding all the values for each activity and dividing this sum by the total number of activities.
Calculating Range

There are two steps involved in calculating the range (lower bound and upper bound) of values of each bin.

**Perform the following to calculate range:**

1. Calculate the binSize by dividing the total number of process instances with total number of bins. The total number of bins are always 9.

   Refer Figure 26 on page 57.

   That is binSize = total process instance count / total number of bins

2. Calculate the Range (Lower bound and Upper bound) of values of each bin as
   a) The Lower bound value is - binIndex times binSize, mathematically rounded.
   b) The Upper bound value is - binIndex plus one times binSize, mathematically rounded.

   For example, if there are 18 instances of an application, then the binSize of that heatmap is
   
   \[ \text{binSize} = \frac{18}{9} = 2 \]

   The range of values stored by the 1st bin is, that is bin index of 0.
   - Lower bound = \((0 \times 2) = 0\)
   - Upper bound = \((0 + 1) \times 2 = 2\)

   The range of the 1st bin (bin with index of zero) would be greater than zero and less than 2. The range of the 2nd bin (bin with index of one) would be greater than 2 and less than 4.

   **Important:** Note that the bin value zero is considered as a separate bin and Business Process Portal displays these process instances in gray in heatmap.

Instance Distribution

While rendering the heatmap, for each activity, Business Process Portal checks how many instances of that application have executed that activity.

For example, if there is a heatmap where the process instance status is completed, and workstep status is completed, then for each activity Business Process Portal calculates how many instances of that application completed that workstep. That value is used to find the fill color of that activity from the heatmap algorithm. The heatmap algorithm then finds out the bin range in which that value falls. If the value falls in one of the bin range values, then that bin’s associated fill color is used for those activities.

For example, if only five instances completed a particular workstep, say workstep1, then you can see which bin holds the value of five. In the above example, the 3rd bin, that is, bin[2] holds the value of five. Therefore, it uses the bin[2]'s fill color while drawing the activity.

The same logic is used where the Process Instance status is active, and workstep status is Activated, Completed or Suspended.

If a workstep is not in the state specified in the user’s filtering criteria in any of the instances, then such a workstep is displayed in gray.

Using this heatmap diagram you can identify which activities are more frequently accessed, less frequently accessed, and those that are never accessed.
Using the Histogram

Business Process Portal renders a Histogram, which is a two dimensional chart with X and Y axis values, using the values calculated for the heatmap. For more information, refer to the Heatmap Algorithm on page 57. In this histogram, the X-axis plots the Activity Execution count, and the Y-axis plots the Instance Range values, that is, bin ranges.

To access the Histogram, click the graph toolbar button in the Heatmap.

The Histogram window is displayed as shown in Figure 27 on page 59.

Figure 27: Histogram

---

Modifying Global Dataslots

Global dataslots are application-level dataslots that occur in each process instance of the application. In previous releases, dataslot values were limited to individual process instances.

To view and/or dynamically update dataslot information globally (i.e., at the application level), from the Management module:

1. In the Management module, from the Application Overview page, click the application name to display Global Dataslots page; or click the Tabular or Flow icon and then click Global Dataslots to display the Global Dataslots page. The Global Dataslots page displays all the global dataslots in that application.
2. Modify the information in the activated boxes as required.
3. Click Save to save your changes. Business Process Server reloads the page and automatically updates the values across all process instances.

To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

---

Updating Application Information

The Application Information feature in the Management module enables you to provide information about an application to the application users.
You can provide the information as a plain text or as a link. The information you specify here is displayed in the Information column on the Applications page of the Home module.

To use the Application Information feature:

1. In the Management module, click **Overview > Applications**. The Application Overview page is displayed.
2. Click the Tabular icon in the Tabular column or the Flow icon in the Flow column. The Tabular or Flow view is displayed.
3. Click the Application Information link. The Application Information page is displayed, as shown below. By default, three rows are displayed.
4. Specify comments or other details in the Information box.
   Optionally, specify a URL in the corresponding URL box. If you specify a URL, then the text you specify in the Information box is displayed as a hyper link which leads to this URL.
5. To add rows, click Add 3 Rows. A set of three rows are automatically added.
   To delete one or more rows, select the checkbox for each row you want to remove and click Delete Rows.
6. Click Save to save the changes.
   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.
Executing and creating reports

This chapter describes how Managers can use either JasperReports or the Business Process Server Report Builder to create new reports or use existing reports to further manage and review Business Process Server applications.
For details, see the following topics:

• Creating and deploying reports using JasperReport
• Setting up Jasper Assistant plugin in Progress Developer Studio for OpenEdge
• Creating and executing reports in Business Process Portal
• Running an existing report
• Creating Application (Query) reports
• Creating Multiapplication reports
• Creating External reports
• Modifying an existing report
• Removing an Existing report
• Task Filtering for reports
• Defining Infopad Reports

Creating and deploying reports using JasperReport

You can use the extensive reporting capabilities of JasperReports — an open source Java reporting tool — to create and execute reports that meet your specific requirements. You may use any JasperReports Designer to create your reports. However, ensure that it is saved as a "jrxml" file. You can deploy your JasperReports as a common report or specific application report.

Important:
While creating reports using iReport tool, it is recommended to set the Language option to Java from the Properties dialog. The default option for Language is Groovy in iReport, Business Process Server does not support Groovy runtime.

Deploying as a Common Report

To deploy your JasperReports as a Common Report in Business Process Server, copy your report file (jrxml) to %WEBAPP_DIR%\ebmsapps\common\reports directory, where %WEBAPP_DIR% is the value of the oebps.webappdir parameter from the OEBPS_HOME\conf\oebps.conf file.

Deploying as an Application Report

To deploy your JasperReports as an application specific report in Business Process Server, in %WEBAPP_DIR%\ebmsapps\<application_name> directory, create reports folder and copy your report file (jrxml) to reports directory. Here %WEBAPP_DIR% is the value of the oebps.webappdir parameter from the OEBPS_HOME\conf\oebps.conf file.
Using a Database other than Business Process Server Connection Pool

If you want to use a database other than Business Process Server, then you must create a file in
the same directory where your report is stored, with the name
<report_name>.properties.datasource. This file should contain the JDBC URL, driver
class, user name and password.

Sample code

A sample of this file is shown below:

```
########################################################################
# This file has been provided to set sample jasper jdbc datasource for sample
# jasper report
# jasper.reports.datasource.url: JDBC URL
# jasper.reports.datasource.driver: Driver Class
# jasper.reports.datasource.user: User
# jasper.reports.datasource.password: Password
########################################################################
jasper.reports.datasource.url=<your_database_url>
jasper.reports.datasource.driver=<your_database_driver>
jasper.reports.datasource.user=<your_database_user>
jasper.reports.datasource.password=<your_database_password>
```

In order to avoid compilation error(s), make sure that the driver classes already exist in your
portalServer class path.

Adding JAR files to Jasper compiler class path

To add your custom classes to Jasper compiler class path, follow these steps:

1. Open the bpmportal.conf file from the %OEBPS_HOME%\server\conf directory.
2. Add your JAR file separated with "|" token to the bpmportal.jasper.compiler.classpath
   attribute, and save the file.

   A sample of this file is shown below:

```
#<param name="bpmportal.jasper.compiler.classpath">
#  <alias>Jasper Compiler Classpath</alias>
#  <visible>true</visible>
#  <description>This classpath is used to set jasper compiler for reports.</description>
#  <legalvalues>Should contain bpmportal.jar, jasperreports.jar, servlet.jar,
#    commons-digester.jar
#    and %APPSERVER%/sbm.war/WEB-INF/classes in classpath format.</legalvalues>
#  <group>CONFINFO</group>
#</param>
bpmportal.jasper.compiler.classpath=%OEBPS_HOME%/lib/bpmportal.jar|
WEB-INF/lib/jasperreports.jar|
WEB-INF/lib/commons-digester.jar<your_class_path>
```
Setting up Jasper Assistant plugin in Progress Developer Studio for OpenEdge

You can use Jasper Assistant plugin with OpenEdge to create your Jasper reports. While installing Progress Developer Studio for OpenEdge, select the Progress Developer Studio for OpenEdge with Eclipse option. You may select other options as per your requirements.

Download the Jasper Assistant Plugin for JasperReports 1.3.0 from the Jasper Assistant website http://www.jasperassistant.com, extract its zip file in a directory, and copy only the feature and plugin directories with their contents to the Progress Developer Studio for OpenEdge installation directory at $DLC\Developer Studio\eclipse. Similarly, also download GEF-runtime-3.0.1.zip from http://www.jasperassistant.com. Note that the GEF-runtime-3.0.1 files starts from default Eclipse directory. Therefore, it is recommended that you extract it into temporary directory and then copy the features and plugins directories with their contents into your $DLC\Developer Studio\eclipse directory.

To create a JasperReport using Jasper Assistant plugin in Progress Developer Studio for OpenEdge:

1. Start the Progress Developer Studio for OpenEdge. From the main menu, select Window > Preferences. The Preferences dialog window appears.

Figure 28: Preferences Window

2. Create a Jasper Report using Jasper Assistant. For more information about creating a Jasper Report, refer to the Jasper Assistant documentation.
3. After creating a Jasper Report, from the File menu, click **Save All** and close Progress Developer Studio for OpenEdge. An application with the name you specified is created in the %STUDIO_HOME%\Workspace directory.

4. Copy this to %OEBPS_HOME%\ebmsapps directory. Create a folder with name reports in the %OEBPS_HOME%\ebmsapps\<application_name> directory. Ensure that the <application_name>.jrxml file is copied from the <application_name>\processtemplates directory to <application_name>\reports directory. This defines it as a application report. You can also copy this file to %APP_SERVER_HOME%\sbm.war\ebmsapss\common\reports directory to define this report as a common report.

5. Publish this application from the OpenEdge.

6. Install the application. The newly created Jasper Reports are listed in the Report List page of the Management module.

**Note:** If you want to specify datasource other than Business Process Server database, then you must create the report.properties.datasource file, and enter the details of the new datasource in it. For more information, see **Using a Database other than Business Process Server Connection Pool** on page 63.

---

### Managing Reports Created Using JasperAssistant

**To access the report you created using JasperAssistant through the Business Process Portal:**

1. In the Management module, click **Reports > My Reports**, to view the Report List page.

2. From the Report drop-down list, select the application where you saved the report you created using JasperAssistant or select **All Reports**. Click Go, and the reports are displayed in the workspace.

3. For JasperReports, a drop-down list is displayed in the View Format column that provides options for the report's presentation. By default, it is set to HTML. Other options include: PDF, RTF, CSV, XLS and XML.

   The XML and XLS options display a link. You can right-click on that link and save the report in your machine to view it locally.

4. JasperReports may also include Broadcast and Schedule options. Click the **Broadcast** icon (/facebook) to open the Broadcast Report page, where you can enter data to automatically email the report to specific addresses.

   You can enter the subject, add comments and select the format of attachments. Options include: HTML, PDF, RTF, CSV, XLS and XML.

5. To run and distribute the report on a specific date and on a predetermined frequency:
   a) Select the Yes option in the Schedule section.
   b) Enter a date in the Date box or click the Select Date icon to display a calendar that facilitates the date entry. Select an option from the Frequency drop-down list.
   c) Click **Save** to execute the Broadcast and Schedule operations. Business Process Server saves these settings after your confirmation.

6. To view the report, select this JasperReport in the Report List page, select a format from the View Format drop-down list, and click **View**.
To modify the report, return to Progress Developer Studio for OpenEdge. Use Business Process Server to only view and/or run the reports developed in Progress Developer Studio for OpenEdge with JasperAssistant plugin.

Creating and executing reports in Business Process Portal

Using the Management module, you can define and execute single application reports, multi-application reports, and external reports. In the Management module, click Reports > My Reports, to view the Report List page. This page presents the three possible scenarios explained in the following table:

Table 11: Reports display scenarios

<table>
<thead>
<tr>
<th>If there are . . .</th>
<th>You will see . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Business Process Server applications specified to be monitored by the user.</td>
<td>No Records Found.</td>
</tr>
<tr>
<td>No existing or predefined reports available.</td>
<td>No Records Found.</td>
</tr>
</tbody>
</table>
| Existing, predefined reports for selected Business Process Server applications, multiple Business Process Server applications, or externally defined reports. | The following information:  
  • The type of report  
  • The application name for which the reports are defined  
  • The name of each report  
  • The description of each report  
  • The format of the report  
  • The number of reports, displayed as Total: x |

Note: No support of localization for database columns.

The Report List page enables you to define your own business reports. Use this page to:

• Execute existing reports.
• Create reports for a single application, multiple applications, and external report servers.
• Test a new query.
• Modify existing reports.
• Define parameters for reports.
• Remove existing reports.
You may have defined several reports in the selected application. Select one of the listed reports and click View to execute the report and view each report instance, listed under the report’s defined attributes (for more information, see Running an existing report on page 68). To create a report, use the Add Report button at the top of the page.

### About Multiapplication reports

Creating multi-application reports enables you to monitor and manage multiple applications at the same time. For example, managers can create a report that lists all application instances for a particular user independent of the application. You can also define reports that perform filtering on various task attributes.

For more information about creating or modifying Multiapplication reports, see Creating Multiapplication reports on page 73. Select Multiapplications from the Report drop-down list on the Report List page to list the available MultiApp reports.

### About external reports

Creating external reports enables you to access and execute reports using external report servers. You can send parameters and values to report servers which generate reports accessible through the Management module of the Business Process Portal. The following table describes the types of external reports.

<table>
<thead>
<tr>
<th>Report type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal Reports</td>
<td>If the Crystal Reports tool is installed on your network, then this option accesses all available reports generated through this application.</td>
</tr>
<tr>
<td>HTML</td>
<td>Similar installation as Crystal Reports except the default URL button is disabled and is not used to create HTML reports. Reports are generated using external reporting servers or ASP in HTML format.</td>
</tr>
</tbody>
</table>
| BPM SQL | Reports generated using BPM SQL. This capability is integrated with Business Process Server, enabling you to place SQL statements in a file (you must use the *.bizsql extension for the database) for execution by the Management module. Typically, this file is stored in the <WebAppDir>BizManage\reports folder under the path that your application server is using. The <WebAppDir> path is the value of the oebps.webappdir parameter from the OEBPS_HOME\conf\oebps.conf file. For example, for JBoss application server, the path is:  
  - For Windows: OEBPS_HOME\jboss\webapps\deploy\sbm.war\BizManage\reports  
  - For UNIX: OEBPS_HOME\jboss\webapps\deploy\sbm.war\BizManage\reports  

Once executed, Business Process Server formats the results and presents the output using standard HTML. Users can view only those BPM SQL reports for which they have been given permissions. These permissions are controlled using the Permission Create page in the Administration module. For more information on BPM SQL security, see the Business Process Portal Administrator’s Guide.
Running an existing report

To execute an existing report, complete the following steps:

1. In the Management module, click Reports > My Reports, to view the Report List page.

2. Select the type of report that corresponds to the existing report you want to execute from the Reports drop-down list at the top of the page, and click Go.

   You can choose between Multiapplications (draws data from more than one application), All Reports (lists all available applications), External Reports (integrates with an external report server), or select a specific application (provides a Query report or an Infopad report for a single application).

3. Select a report from the list of reports, select the format in which the report is to be presented from the View Format drop-down list, and click View to run the report and display it in the View Report page.

   For all reports except Infopad Reports, the View Format drop-down list contains HTML, PDF, and RTF option, whereas, for Jasper Reports, in addition to these, it also contains CSV, XLS, and XML options. Business Process Portal does not display the View Format drop-down list for an Infopad Report.

   The report name is displayed above the table, and each process instance within the report is listed as a row in the table. Columns represent attributes you selected when creating the report (see Creating Application (Query) reports on page 68).

   You may use various options, controls, and links available on the View Report page to see more details.

Creating Application (Query) reports

This section describes how to use Business Process Server’s Report Builder to define new queries and create reports of application and task instances from a single application. After first defining a new query, the user can then save the defined query as a new report.

Note: See Creating External reports on page 76 for more information on defining a query and creating External Reports.

To define a new query:

1. From the Report List page, select the report type from the drop-down list at the top of the page (refer to Creating and executing reports in Business Process Portal on page 66).
Selecting Query Report enables you to create a report from one of the installed applications.

2. Click Add Report, and the Add Application (Query) window for the report type you chose in the preceding step opens, as seen in Figure 29 on page 69.

**Figure 29: Add Report Window**

3. Select the application for which you want to create a report from the Application drop-down list.

4. Click Query to display the Query dialog window (see Figure 37 on page 77). Business Process Server selects the Application Report type and the Application Attributes tab by default. The list of attributes shown in this Application Attributes tab differs from the attributes associated with a Multiapplication Report.

5. Select one of the following report types:
   - **Application Report.** Business Process Server retrieves only the application attributes, which are displayed in the panel on the left of the Query dialog window.
- **Task Report.** As shown in Figure 30 on page 70, Business Process Server retrieves application attributes and all task attributes (work items) related to the application that have been assigned to the user.

**Figure 30: Application Attributes Tab in Query Dialog Window**

6. Select the application and/or task attributes you want to include in the query definition (which can later be saved as a new report).
   
   The Name attribute is mandatory and is always selected.

7. Click the **Filters** tab.

   The **Filters** tab (see Figure 31 on page 71) enables you to customize the information presented in your reports. Select attributes for the filter from those listed in the Select Attributes panel. The contents of the **Define Filter** panel changes to match the particular attribute selected in the Select Attributes panel.
8. To define a filter, type the reference value into the Name text box in the central section of the **Query** dialog window, or click the **ellipsis** button ( .. ) next to the Name text box to have Report Builder display the list of all available values that have been defined as in Figure 31 on page 71.

**Figure 31: Filters Tab in Query Dialog Window**

9. After selecting and defining a filter to apply to the new query definition, click **Add**.

   Business Process Server adds the filter to the list in the Current Filters panel. Use the **Delete** button to remove selected filters from this list.

10. Add additional filters, when required.

11. Click the **Options** tab and enter a brief description in the text box.
This optional description appears on the **Reports** page beside the report name (refer to Figure 32 on page 72).

**Figure 32: Options Tab in Query Dialog Window**

12. Click **Apply** to view the results, which Business Process Server displays in the **View Report** page.

13. Refine the results, if necessary, and then click **Apply** to view the new result in the **View Report** page.

   In this page, you can click the instance name from the Name column to see the **View Dataslot** page of the selected instance. Click **Cancel** to close the **View Dataslot** page and go back to the **View Report** page. Click **Cancel** to close the **View Report** page and go back to the **Query** dialog window.

14. To create a new report, click **Save As**.
15. In the **Save As** dialog box, enter a name for the new report in the Report Name box and click **Save**.

Figure 33: Saving a Query to Create a Report

![Image](image)

**Note:** Business Process Server cannot display a report that includes the forward slash (/) in its name. Therefore, it is recommended that it should not be used in the report name.

16. Click **Close** to exit the Report Builder.

Business Process Server displays all saved reports for the selected report type and the selected application in the Select a Report panel.

---

**Creating Multiapplication reports**

This section describes how to use Business Process Server’s Report Builder to define new queries and create reports of application and task instances from multiple applications. After first defining a new query, the user can then save the defined query as a new report.

**Note:** See **Creating External reports** on page 76 for more information on defining a query and creating External Reports.

**To define a new query for multiple applications:**

1. From the **Report List** page, select Multiapplication Report from the drop-down list at the top of the page.

   Refer **Creating and executing reports in Business Process Portal** on page 66.

   Selecting Multiapplication Report enables you to create a report from all or multiple installed applications.


3. Select one of the applications for which you want to create a report from the Unselected Applications panel and click **Add** to add it to the Selected Applications panel.

4. Click **Add All** to add all the applications listed in the Unselected Applications panel to the Selected Applications panel. Click **Remove** or **Remove All** to delete one or all of the applications listed in the Selected Applications panel.
5. Click Query to display the Query dialog window.

Refer Figure 37 on page 77.

Business Process Server selects the Application Report type and the Application Attributes tab by default. The list of attributes shown in this Multiapplication Attributes tab may differ from the attributes associated with a single Query report (for a single application).

6. Follow procedures described in steps 5-16 in Creating Application (Query) reports on page 68 to complete the creation of a multiapplication report.

**Defining Parameters for Application and Multiapplications reports**

Business Process Server’s Management module enables you to create parameters for application attributes, generating dynamic reports based on values that can be specified at the time the report is executed. After defining one or more parameters, Business Process Server prompts you to supply these values when you execute the query or report.

**To define a new parameter, complete the following steps:**

1. In the Query dialog window, click the Filters tab, then Define Parameter, to open the Define Parameters dialog window.

Refer to Figure 34 on page 74.

**Figure 34: Define Parameters Dialog Window**

2. Type the name of the parameter in the Name box and enter the corresponding user prompt.
3. Enter a default value for the parameter.
4. Click Add to register the parameter. The parameter appears in the Current Parameters panel, and can be used for the current report or any future report.
Whether creating a query or modifying a report, you can define parameters of report filters that generates reports based on a specific set of selected data.

**Defining parameters for report filters**

To define parameters for report filters, complete the following steps:

1. In the **Query** dialog window, click the **Filters** tab.
2. Select attributes of the filter parameter from the Select Attributes panel.
3. Set the **Use Parameter** checkbox.
4. Click **Select Parameter**.

Business Process Server displays available parameters in the drop-down list illustrated below. **Figure 35: Selecting a Filter Parameter**

5. Select a parameter from the Select Parameter drop-down list.
6. Click **Add**.

Business Process Server adds the filter parameter to the list displayed in the Current Filters panel.

7. Click **Save** to save the report.

**Note:** While executing the query or report, a prompt appears to supply the defined parameter. Enter the value and click **Go** to generate the report.
Report Versioning

You can run a multiapplication report on an application that has more than one versions. You can save this report. If you add more versions of this application, then the multiapplication report automatically reports on each added version, but only when these versions have the same application name; for example, Approval_V4, Approval_V5, Approval_V6.

Creating External reports

Business Process Server enables you to integrate externally defined reports. Use the Business Process Server Report Builder to create external reports that can access and execute reports using external report servers.

To define an External report, complete the following steps:

1. From the Report List page, select External Report from the Report drop-down list at the top of the page.

   Refer to Figure 36 on page 76.

   Selecting External Report enables you to create a report that can access and execute reports using external report servers.


   Figure 36: Add External Report page

3. Select the generator of the report from the Type drop-down list. Options include Crystal, HTML, and BPM SQL. See Table 12 on page 67 for a description of the External report types.
4. Click **Query**. Business Process Server displays the **Query** dialog window opened by default to the Custom Report tab. You can change the report generator, if required, using the Report Type drop-down list.

**Figure 37: Query window for External Report, Custom Report Tab**

![Query window for External Report](image)

5. When creating HTML reports, enter the URL of the HTML server in the **Report URL** box. For HTML, the default URL button is enabled only when the value is available in the .conf file; otherwise the Default URL button is disabled and therefore cannot be used as a basis for creating the reports.

6. When creating Crystal Reports, enter the URL of the Crystal Report server in the **Report URL** box. Alternately, click the **Default URL** button to have Business Process Server fill in the default Crystal Report Server specified in the `bpmportal.conf` configuration file, if available.

7. When creating BPM SQL reports, specify a file name instead of a URL in the Filename box. This file contains the SQL statements for execution by Business Process Server. The BPM SQL files are in the `<App_Server>/sbm.war/BizManage/reports` directory. The file extension is `*.BizSQL`, which works for all databases. The path to the BPM SQL file depends on the application server you are using. See **Figure 39** on page 80.

**Note:** If you want to include the Chart View in your BPM SQL report, then your query must contain following parameters from Business Process Server database:

```
process_template_name, process_template_id, process_instance_name and process_instance_id
```

Note the following conditions when using BPM SQL syntax:

a) You must use the exact syntax when developing BPM SQL reports. The following parameterized SQL query is provided as an example:

```
select * from processinstance where processinstance.creator = '<<=% who %>>'
```
where the parameter value must be enclosed within the `<%= %>` tag, and you must enter a space before and after the query name. The tag must also be enclosed with single quotes. Optionally, you may also use non-parameterized SQL queries, the syntax for which is as shown in the following examples (in these examples, `*` = all):

- `Select * from processinstance where processinstance.creator IN '<%= who %>'`
- `Select * from processinstance where processinstance.creator = '<%= who %>'`
- `Select * from processinstance where processinstance.creator NOT '<%= who %>'`

Please make sure that you enter the SQL query as is shown in the above examples with appropriate changes as per your requirements.

b) Do not put a semicolon at the end of the SQL statement; it causes an invalid character error.

c) Use the following syntax when you want to display a valid field under a customized label in Business Process Portal:

```sql
select field1 AS label1, field2 AS label2, field3 as label3,... from table name
```

or in a specific example:
```
Select PROCESSINSTANCE.PROCESSINSTANCENAME AS Task from PROCESSINSTANCE
```

where `PROCESSINSTANCE.PROCESSINSTANCENAME` is the field, `Task` is the label and `PROCESSINSTANCE` is the table name.
8. To define parameters for External reports:
   a) Enter a parameter name and value in the **Parameter Name** and **Parameter Value** boxes respectively, and click **Add**. Use these parameters to uniquely identify the report.
   b) Business Process Server adds the parameter definition to the **Current Parameters** drop-down list.

   **Figure 38: Specifying Report Parameters and Values**

   ![Image of specifying report parameters]

   c) To add more parameters, repeat the preceding steps.
   d) To remove a parameter, select it from the **Current Parameters** drop-down list and click **Remove**.

9. When using BPM SQL as the report generator, Business Process Server substitutes the parameters into the file containing SQL statements, enabling you to define parameterized SQL statements. When entering parameters and values, follow the SQL syntax. For example, in the **Parameter Name** box, use the following format to enter parameter names in the BPM SQL query file:

   `parameter_name` or `‘parameter_name’`
As shown in the example above, the parameter value may be given without single quotes or within single quotes, depending on the SQL syntax. For example, if the parameter’s value is part of a Where clause, then it is in single quotes.

Figure 39: Specifying Parameters for BPM SQL

10. Click the Options tab and enter a description of the new report in the Description text box. This description appears on the Report List page beside the report name.
See Figure 40 on page 81.

**Figure 40: Adding a Report Description**

![Adding a Report Description](image)

11. Click **Apply** to view the results, which Business Process Server displays in the Report Parameters window.

12. Refine the results, if necessary, and then click **Submit** to view the new results in the **View Report** page.

   In this page, you can click the instance name from the Name column to see the Chart View of the selected instance. Click **Cancel** to close the Chart View and go back to the **View Report** page. Click **Cancel** to close the **View Report** page and go back to the **Query** dialog window.

13. Click **Save As** to open the **Save As** dialog box (see below) to create a new external report.

**Figure 41: Saving a Query to Define a Report**

![Save As Dialog](image)
14. Enter a name for the new report in the Report Name box and click **Save**. Do not use the forward slash (/) character in a report name. Business Process Server cannot display a report that includes ‘/’ in its name.

15. Click **Close** to exit the Report Builder.

   Business Process Server displays all saved reports on the **Report List** page for the selected report generator.

   As shown in **Figure 41** on page 81.

---

**Modifying an existing report**

Many of the same procedures that were used to create a new Query (Application), Multiapplication or External report can be used to modify an existing report.

**To modify an existing report:**

1. In the Management module, click **Reports > My Reports**, to view the **Report List** page, and then select a report from the Report Name column.
Removing an Existing report

To delete an existing report, navigate to the Report List page. Select the report to be deleted from those listed on the page, and click Delete.

Refer #unique_87.

Task Filtering for reports

Business Process Server provides extended task filtering capabilities for more effective report building. Using task filtering, managers can create reports filtered on task attributes. Managers are able to define complex task reports through the existing Business Process Portal interface, and don’t need to navigate to the BPM SQL report facility.
**Note:** The task filter cannot entirely replace the BPM SQL report facility, which can manipulate any database table, not just the workstep and work item tables.

For example, you can specify which tasks are to be displayed, and can choose from all the tasks of a particular instance to none of the tasks of a particular instance. The Report Builder supports the definition of filters on the following task items:

- Task name
- Creator
- Task status
- Task priority
- Task start/end time

The task filtering feature is built into the Report Builder interface on the **Report List** page. With task filtering built into the interface, you can specify conditions of any task attribute and not lose the previous capabilities, such as filtering process instances based on the priority of a particular workstep.

For example, the manager of a Hiring application can list all the instances with an Evaluate Resume task that has an Active status and a High priority. Furthermore, if the report was defined as a task report, then the list of worksteps that are *only* active is displayed, as well as all tasks (active as well as completed, removed and suspended) related to the instances.
Using Task Filtering for Reports

To use task filtering in reports:

1. For new reports, from the Report List page, click Add Report. Select appropriate options from the Type and Applications panels, and click Query. For existing reports, select the report you want to revise and click Edit Report icon.

2. The Query dialog window appears, open to the Application Attributes tab. Select Task Report from the Report Type drop-down list in the Query dialog window.

   **Figure 43: Application Attributes for Task Reports**

3. From the tasks listed in the right panel of the Query dialog window, select the tasks to be displayed in the report.

4. From the attributes listed in the left panel of the Query dialog window, select the work item attributes to be displayed in the report.

5. Click the Filters tab.

   Refer Figure 43 on page 85.

   To define a filter for work item attributes, select an attribute from the Select Attributes panel. Each time the user selects one of the attributes, the contents of the Define Filter panel changes. Type a reference value into the text box in the Define Filter panel, or click the ellipsis button (●) beside the text box to let the Report Builder display a list of available values. After defining the filter, click Add. Business Process Server adds the filter to the list in the Current Filters panel. Add additional work item attribute filters as required.

   To define a filter for task attributes, select an attribute from the Task Attributes panel in the lower left of the page.
Refer Figure 43 on page 85.

Each time the user selects one of the task attributes, the contents of the Define Contents panel changes. Enter appropriate information in the Define Filter panel. After defining the filter, click Add. Business Process Server adds the task attribute filter to the list in the Current Filters panel. Add additional task attribute filters as required.

**Note:** In the case of task reports, you can find another option, <Any Task>, in the work item sub-panel to define a filter on a task attribute independent of the work item name.

**Figure 44: Filters Tab for Task Reports**

6. Click the Options tab. Enter a brief description of the report in the activated text box. The description appears on the Reports page beside the report name.

7. Click Save As when all task report filters have been defined.

8. Enter the name of the new report in the Save As dialog window, and click Save.

9. Click Close to exit the Report Builder.

Business Process Server displays all saved reports on the Report List page.

Refer to sCreating and executing reports in Business Process Portal on page 66.

**Updating previously created reports with Task Filtering**

It is possible to open a report created in an earlier version of Business Process Server and add the task filtering functions to the report.
Defining Infopad Reports

BPM Events uses a data structure called an infopad to store:

- Application parameters (for example, the list of product purchase limits for different departments)
- Rule parameters (for example, the critical threshold for a resource load)
- Any other global data that the rules may require.

Infopads are stored in the Business Process Server repository. An infopad is a single- or two-dimension table, which is composed of cells. Each cell is a data structure that contains a cell slotname and a value. For more detailed information on infopads, see the Infopads chapter in the BPM Events User's Guide.

Business Process Server enables you to create a detailed analysis report of an infopad associated with one or more applications. These reports are called infopad reports.

In the Report List page, select Infopad Report from the list adjacent to the Add Report button. You can then perform the following actions on the infopad reports.

**Table 13: Infopad Report Actions**

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Report button</td>
<td>Create a new infopad report.</td>
</tr>
<tr>
<td>Edit Report icon</td>
<td>Modify an existing infopad report.</td>
</tr>
<tr>
<td>Delete button</td>
<td>Delete the selected infopad report.</td>
</tr>
<tr>
<td>View button</td>
<td>Display the selected infopad report.</td>
</tr>
</tbody>
</table>

Business Process Server offers a highly visual set of charts for infopad reports, which can help you monitor Business Process Server applications at a higher level. Select from one of the following analysis formats:

- Table
- Graph
- Table & Graph
- Excel Spreadsheet
To create a detailed analysis report using infopads, complete the following steps:


   **Figure 45: Add Application(Infopad) Report Page**

2. Specify the information and format for the infopad report. The following table lists infopad report options:

   **Table 14: Infopad Report Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select an application for which you want to create a report.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Specify a name for the report.</td>
</tr>
<tr>
<td>Report title</td>
<td>Specify the title that is displayed on the infopad report.</td>
</tr>
<tr>
<td>Report description</td>
<td>Specify the description that is displayed on the infopad report.</td>
</tr>
<tr>
<td>Infopad</td>
<td>Select the infopad you want to analyze from the drop-down list.</td>
</tr>
<tr>
<td>Row and Column</td>
<td>Business Process Server automatically chooses a row and column for the report when you select the infopad, but you can change these default selections.</td>
</tr>
<tr>
<td>Slice on</td>
<td>Business Process Server automatically chooses the dataslot displayed in the infopad composer, but you can change the default selection.</td>
</tr>
<tr>
<td>Chart type</td>
<td>Choose from the following: Line Chart, Pie Chart, Area Chart, Multi-row Bar Chart, Multi-column Bar Chart, Stacked Bar Chart, or Stacked Area Chart.</td>
</tr>
<tr>
<td>Pie Chart On</td>
<td>Select Row or Column, when the Pie Chart option was selected in the Chart Type drop-down list.</td>
</tr>
</tbody>
</table>
To show your data correctly in the selected Chart type, you must define more than one row or column in either the row dimension or the column dimension. To display the Area Chart and Stacked Area Chart types correctly for infopads, make sure that you select an option from the Column drop-down list that contains at least one row and more than one columns.

### Note:
You can use the Permission Create page in the Administration module to control the permissions to multiple infopads. For more information on BPM Events security, see the Business Process Portal Administrator’s Guide.

3. Click **Preview**. A new window opens, displaying the Infopad Report based on the specified settings. Click the **Graphical View** tab, to verify whether your infopad report presents the data as required or not. Click **Close this window** to return to the Add Application (Infopad) Report page.

4. Click **Save** to save the current report. Click **Save & Add New** to save the current report and reload the page to allow you to add another report.

   Click **Reset** to delete your changes and display the original settings.

   Click **Cancel** to delete your changes and return to the previous page.
Using the Instance Manager

In today's business environment, a system may have hundreds of performers creating thousands of instances. As a user in this type of system, you may want to modify large numbers of instances, worksteps and tasks in batches, rather than on a more time-consuming, one-by-one basis. The Instance Manager enables you to efficiently manage existing instances and their tasks in batches, by performing the following procedures:

- **Search through all existing instances and their tasks.** Use the Instance Manager's Search function to filter through instances and tasks for date, name, creator, and priority attributes.

- **Update batches of process instances and worksteps.** All instances or worksteps, system attributes or dataslots retrieved by the Instance Manager's Search function can be updated with a single click.

- **Dynamically change instance properties at run-time.** Instance Manager enables you to change application properties at the instance level and the task level, even when the application is up and running. You can change instance and task properties or change attribute or dataslot values at run-time.

**Note:** Instance Manager only works with existing instances and their tasks. To change template-level properties at run-time, you must use other Management features.

- **Perform bulk updates of instances in Management reports.** You can quickly update selected groups of user defined dataslots.

- **Reassign tasks in batches.** In some systems, you, as a Manager, can create hundreds of instances of an application, which are automatically assigned to you. You can then use the Instance Manager to reassign all or a selected batch of tasks to a specific performer. In case
of employees on vacation or leaving the company, you can also reassign batch of these tasks to a specific performer.

- **Assign "Available Status" tasks to specific performers.** In Business Process Server, if the performer of a task is a group and the role is "any", then the status of this task is "Available" to any member of the group until it is actually assigned to a specific performer. Using Instance Manager, you can conveniently retrieve such groups of tasks and assign a batch of them to a specific performer or to another group.

For details, see the following topics:

- Launching the Instance Manager
- Reassigning Assigned Tasks
- Reassigning Available Tasks
- Updating Worksteps
- Resuming Suspended Worksteps

### Launching the Instance Manager

The Instance Manager feature can be described as a Web Application running in the Management module. To launch the Instance Manager from the Management module of Business Process Portal, in the Management module, click the **Instance Manager** menu and select one of the submenu options.

In order for the Instance Manager to function, Business Process Server must be running. When you start Instance Manager, it first verifies that Business Process Server is running. If it is not running, then it displays a warning message. When this warning is displayed, you must log out of Business Process Portal, launch Business Process Server, and log in to Business Process Portal, and then access Instance Manager again.

Instance Manager enables you to select the application that you want to monitor or manage. You can only select one application in the Instance Manager.
The Instance Manager enables you to manage at the following levels:

- **Instance Level**, where you can:
  - Click **Search Criteria** to search for and view a list of process instances, and change one, a selected batch, or all process instance properties in the selected application.
  - Click **Display Attributes** to modify dataslots in the selected application.
  - Click **Reports** to modify system attributes in BPM Manage API reports in the selected application.

- **Task Level**, where you can:
  - View the tasks for all performers, or search a specific performer.
  - Reassign one, a selected batch, or all assigned tasks of a performer, or reassign the available tasks of a performer.

- **Workstep Level**, where you can:
  - Click **Search Criteria** to search for a specific, or a selected group of worksteps.
  - Click **Worksteps** to update all, or selected worksteps.
  - Click **Display Attributes** to modify workstep attributes of the selected application.

### Updating Process Instances

To update one process instance, a selected batch of process instances, or all process instances:

1. In the Management module, click **Instance Manager > Instances**, to view the **Search Instances** page.

   ![Figure 46: Search Instances Page](image)

2. Select an application from the **Application** drop-down list at the top of the **Search Instances** page. To further define your search on a specific attribute, select the **Attributes** option, and click **Go**.

   The **Search Instances** page, contains the Search Criteria, and Display Attributes tabs. It enables you to refine your search.
3. Click the **Search Criteria** tab, and enter relevant data in the Instance Name, Creator, Priority, Start Date and Due Date boxes.
   a) In the Instance Name box, enter the name of the Instance that you want to retrieve. Note that the search engine is case sensitive.
      
      By default, an asterisk (*) is entered, which means that all instances are displayed.
   b) In the Creator box, enter the name of the Creator that you want to retrieve in the text box. Note that the search engine is case sensitive. By default, an asterisk (*) is entered, which means that all creators are displayed. Alternatively, click the **Edit Creator** icon to open the **Search Users** page (for more information, see Searching Users on page 36).
   c) In the Priority box, select an option from the drop down list. The option "All" is selected by default.
   d) In Start Date and Due Date boxes, specify a time period from the options in the corresponding drop-down list. Alternatively, click the **Select Date** icon ( ) to set the respective start date or due date. For more details, see Specifying a Date on page 35. By default, all dates are specified.

   **Note:** If you use the defaults and make no entries on the **Search Instances** page, then a list of all active instances for the selected application is returned by default.

4. Click the **Display Attributes** tab. It displays a list of dataslots. Select the check boxes for the dataslots that you want to change.

   **Note:** Dataslots of type Object, Map, and List are not displayed in the Display Attributes tab.

5. Click **Search** to retrieve all instances that meet the search criteria you have specified.

6. The search results are presented in the **Instance List** page.

   Refer **Figure 47** on page 95.

   This page contains two frames: the top frame displays all instances you had selected in step 3 and dataslots that you had selected for display in step 4; and the bottom frame allows you to apply common values to selected dataslots. As seen in the top frame, instances are presented in a tabular format, with each row representing an instance. Instance name and dataslots are displayed in columns.
If no attributes are selected, then the Instance List page displays all the instances you have selected excluding the dataslot. It displays only Remove, Remove All and Cancel options.

Figure 47: Instance List Page

If your search has retrieved many instances, then they are presented in multiple pages. To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 24.

Note: You can customize the number of instances that are displayed on a single page by modifying the bpmportal.page.size property in bpmportal.conf file.

7. To modify data for specific instances, click the link in the Instance column. The details of the selected instance are displayed in the bottom frame.
   a) Enter new information about the displayed dataslots in the corresponding value boxes for the instance(s).
   b) To apply common values to selected instances and/or clicked instance displayed in the top frame, make modifications to the dataslot values displayed in the bottom frame, and click Apply. You can also apply common values to all instances displayed on the page by selecting the checkbox in the heading of the table in the top frame.
      Refer Figure 47 on page 95.
   c) Click Save to save the new data after your confirmation.

Note: To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

8. Click Update All to apply common values to all instances displayed on all pages. A Warning appears, stating that all instances for the selected application is updated and asks do you want to continue. You cannot undo this operation, so make sure all information is correct. Click OK and a Confirmation message appears, indicating the update was successful. Click OK to return to the Instance List page.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.
Updating Instances Using Reports

To perform a bulk update of user defined dataslots that are in an existing report (i.e., a report that you have previously defined):

1. In the Management module, click **Instance Manager > Instances**, to view the **Search Instances** page.
2. Select an application from the **Application** drop-down list at the top of the **Search Instances** page. To further define your search on a specific report, select the **Reports** option, and click **Go**.

Business Process Portal displays a list of ‘Application’ reports for the selected application. Refer [Figure 48](#) on page 96.

**Note:** Dataslots of type Object, Map, and List are not displayed.

3. Select a report, and click **Search**, to open the **Instance List** page.

**Note:** Search does not list the reports designed in the Jasper Report, Multiapplication Report, External Report and Infopad Report Designer.

![Figure 48: Reports List Page](#)

4. Follow procedures similar to those described in steps 6 - 8 in Updating Process Instances on page 93.

Removing Instances

As a Manager, you can remove instances created by you as well as by others.

**To remove instances:**

1. Follow the procedure described in steps 1 - 6 in the Updating Process Instances on page 93 to locate the instances for removal.
2. If you want to remove only a few instances, select them from the top frame and then click **Remove**. To remove all instances, click **Remove All**.
Reassigning Assigned Tasks

To reassign one assigned task, a selected batch of assigned tasks, or all assigned tasks to specified performers:

1. In the Management module, click Instance Manager > Tasks, to view the Performer List page.
2. Select an application from the Application drop-down list.
3. Select Assigned from the Task Type drop-down list, and click Go. The Performer List page is displayed.

Figure 49: Performer List Page

4. Before you reassign tasks, you need to select the performers whose tasks you want to reassign. To locate specific performers, use the search functions on the Performer List page.
   a) To search for all performers for a specific search criteria, enter an asterisk (*) in that search field.
   b) The asterisk also serves as a wild card for the Performer box. For example, you can search for users named McPherson by entering any of the following:
      • Mc* locates all performers with a name beginning in Mc.
      • *pher* locates all performers with names containing "pher".
      • *son locates all performers with a name ending in "son".
      • M*n locates all performers with names starting with M and ending with n.
   c) Click Search. The Reassign Assigned Tasks page is displayed.

Note: The Performer List page displays only user and group performers. It does not display any performer for a task having queue as a performer.
5. The **Reassign Assigned Tasks** page enables you to reassign an assigned task (i.e., change the performer property of a task). This page contains two frames: the top frame lists the specified performers for the selected application; the bottom frame enables you to select a common performer for all the instances listed in the top frame.

**Figure 50: Reassign Assigned Tasks Page**

6. On this page you can perform the following functions:

a) To reassign the selected task(s) to a common performer:

   - Select one or more specific task checkbox(es) in the top frame.
     
     You can select the checkbox in the column header to select all the tasks on the current page.

   - Enter a performer’s name in the **Common Performer** box or use the **Edit Performer** icon (-edit) to open the **Search Users** page, where you can search for, then add, a specific performer.

   - Click **Apply**. The selected tasks are reassigned to the specified performers after your confirmation.

   - Click **Save**. Business Process Server saves the current settings.

b) To reassign all task(s) across all pages to a common performer:

   - Enter a performer’s name in the **Common Performer** box or use the **Edit Performer** icon (-edit) to open the **Search Users** page, where you can search for, then add, a specific performer.

   - Click **Reassign All** to reassign, with one click, a batch of tasks to various performers. A warning appears, stating that all tasks for the selected application is reassigned and asks if you want to continue. You cannot undo this operation, so make sure all information is correct. Click **OK**. All tasks are reassigned to the specified performers after your confirmation.
Reassigning Available Tasks

If the performer of a workstep is a list of names or a group with the role of "any", then its tasks have an Available status when they are created, and remain in this status until you assign them to a specific performer.

To reassign one available task, a selected batch of available tasks, or all available tasks to specified performers:

1. In the Management module, click Instance Manager > Tasks, to view the Performer List page.
2. Select an application from the Application drop-down list.
3. Select Available from the Task Type drop-down list, and click Go. The Performer List page is displayed.

4. Before you reassign tasks, you need to select the performers whose tasks you want to reassign. To locate specific performers, use the search functions on the Performer List page. After selecting a user, click Search.
5. The Reassign Available Tasks page enables you to reassign an available task. This page contains two frames: the top frame lists the specified performers for the selected application; the bottom frame enables you to select a common performer for all the instances listed in the top frame.
6. The procedures for reassigning available tasks are very similar to procedures described in step 6 in Reassigning Assigned Tasks on page 97.

Updating Worksteps

You can now update data at the workstep level. The bulk update feature for worksteps allows you to enter search criteria for instances, select specific worksteps and choose which dataslot attributes are displayed.
To update one workstep, a selected batch of worksteps, or all worksteps:

1. In the Management module, click Instance Manager > Worksteps. The Search Worksteps page is displayed.

2. The Search Worksteps page contains three tabs: Search Criteria, where you can select one or more instances; Display Attributes, where you can choose which dataslot attributes will be displayed; and Worksteps, where you can select one or more worksteps.

Figure 51: Search Worksteps Page

3. Select an application from the Application drop-down list, and click Go.

4. The Search Worksteps page has a format similar to the Search Instances page. Please refer to the procedures described in Updating Worksteps on page 99 in Updating Process Instances on page 93.

5. Use the Search Criteria tab to specify search criteria that locates and displays worksteps of the selected application that meet the search criteria. Ensure that you have selected Activity from the Workstep Type drop-down list.

6. Open the Display Attributes tab to display a list of workstep attributes. Select the check boxes for the workstep attributes that you want to change.

7. Open the Worksteps tab to specify the worksteps you want to locate.

8. Click Search to retrieve all work items that meet the search criteria you have specified.

9. The search results are presented in the Workstep List page Step Figure 52 on page 101. This page contains two frames: the top frame displays all worksteps selected in step 5, and identifies their associated instance as well as workstep attributes that you had selected for display in step 6. The bottom frame allows you to apply common values to selected workstep attributes. Only for the following workstep attributes you can change the value:

   - Next Activation Performer
   - Status
   - Priority
   - Due Date
As seen in the top frame, worksteps are presented in a tabular format, with each row representing a workstep. Workstep values are represented as columns.

**Figure 52: Workstep List Page**

If your search has retrieved many worksteps, then they are presented in multiple pages. To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see *Exploring Business Process Portal* on page 24.

**Note:** You can customize the number of worksteps that are displayed on a single page by modifying the `bpmportal.conf` file.

10. To modify data for the selected worksteps, click the link in the Instance column. The details of the selected workstep are displayed in the bottom frame.

   a) Enter new information about the displayed dataslots in the corresponding value boxes for the workstep(s).

   **Note:** If you change the performer from the Workstep List page, then this change is effective only when that workstep is reactivated. Therefore, it is recommended not to change the performer from this page. You should do this change from the Performer List page. For more information, see *Reassigning Assigned Tasks* on page 97.

   b) To apply common values to selected instances and/or clicked instance displayed in the top frame, make modifications to the dataslot values displayed in the bottom frame (see ), and click Apply. You can also apply common values to all instances displayed on the page by selecting the checkbox in the heading of the table in the top frame.

   Refer Step Figure 52 on page 101.

   c) Click Save to save the new data after your confirmation.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.
11. Click **Update All** to apply common values to all instances displayed on all pages. A Warning appears, stating that all instances for the selected application is updated and asks do you want to continue. You cannot undo this operation, so ensure all information is correct. Click **OK** and a Confirmation message appears, indicating the update was successful. Click **OK** to return to the **Workstep List** page.

12. To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

## Resuming Suspended Worksteps

You can resume the suspended workstep(s).

**To resume one workstep, a selected batch of worksteps, or all worksteps:**

1. In the Management module, click Instance **Manager** > **Worksteps**. The **Search Worksteps** page is displayed.

2. The **Search Worksteps** page contains three tabs: Search Criteria, where you can select one or more instances; Display Attributes, where you can choose which dataslot attributes is displayed; and Worksteps, where you can select one or more worksteps.

   **Figure 53: Search Worksteps Page**

3. Select an application from the **Application** drop-down list, and click **Go**.

4. The **Search Worksteps** page has a format similar to the **Search Instances** page. Please refer to the procedures described in **Updating Worksteps** on page 99 in **Updating Process Instances** on page 93.

5. Use the Search Criteria tab to specify search criteria that locates and display worksteps of the selected application that meet the search criteria.

   Depending on whether you want to resume worksteps to which human performers or adapters are assigned, select **Activity** or **Adapter/Agent** respectively from the Workstep Type drop-down list

6. Open the **Display Attributes** tab to display a list of attributes and dataslots. Select the check boxes for the attributes and/or dataslots that you want to change.

7. Open the **Worksteps** tab to specify the worksteps you want to locate.

8. Click **Search** to retrieve all work items that meet the search criteria you have specified.
9. The search results are presented in the **Workstep List** page. This page contains two frames: the top frame displays all worksteps selected in step 5, and identifies their associated instance as well as dataslots that you had selected for display in step 6. The bottom frame allows you to apply common values to selected dataslots.

Refer Step Figure 54 on page 103.

As seen in the top frame, worksteps are presented in a tabular format, with each row representing a workstep. Workstep values are represented as columns.

**Figure 54: Workstep List Page**

![Workstep List Page](image)

If your search has retrieved many worksteps, then they are presented in multiple pages. To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 24.

**Note:** You can customize the number of worksteps that are displayed on a single page by modifying the `bpmportal.conf` file.

10. In the top frame, select the worksteps whose status is to be changed to Resume.

11. In the bottom frame, select **Active** from the **Status** drop-down list, and then click **Apply**. You can also change the status of all instances displayed on the page by selecting the checkbox in the heading of the table in the top frame.

12. Click **Save** to save the new data after your confirmation.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

13. Click **Update All** to apply common values to all instances displayed on all pages. A Warning appears, stating that all instances for the selected application are updated and asks if you want to continue. You cannot undo this operation, so make sure all information is correct. Click **OK** and a Confirmation message appears, indicating the update was successful. Click **OK** to return to the **Workstep List** page.

14. To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.
Using the Balanced Scorecard

Balanced Scorecard is a performance management system that enables senior management to measure how their organization’s business activities are helping it meet its strategic goals. Balanced Scorecard provides you a Manager with a method of statistically measuring your company’s performance, using a scale of 0-10, resulting in a balanced, high-level view of all areas of your enterprise.

For details, see the following topics:

- Using the Balanced Scorecard
- Using the Balanced Scorecard Designer

Using the Balanced Scorecard

Balanced Scorecard enables you to look at your strategic goals from not just one, but a range of, perspectives that typically include:

- **Finance.** Presents data from the perspective “To succeed financially, how do we appear to our shareholders?”
- **Customer.** Presents data from the perspective “To achieve our strategic goals, how do we appear to our customers?”
- **Innovation.** Presents data from the perspective “To achieve our strategic goals, how are we sustaining our ability to change and improve?”
- **Internal.** Presents data from the perspective “To satisfy our shareholders and customers, what business processes must we excel at?”
Each of these Balanced Scorecard Perspectives are derived from key performance indicators (KPIs) that provide the data that translate enterprise goals into a set of measurable objectives. For example, the Finance Perspective can contain such KPIs as Product Revenue, Service Revenue, Product Revenues Growth, Service Revenues Growth, Profit Margin and Sales Pipeline. Each of these KPIs can be assigned a weight that indicates its comparative significance.

Combining Business Process Server and Balanced Scorecard

The Management module of Business Process Portal provides business process management at the business unit or department level, and the Balanced Scorecard is also typically management focused, even though you can drill down through the organization. The combination of Business Process Server and Balanced Scorecard provides a unique business approach that enables you to compare Business Process Server’s business process intelligence against the measurement of corporate strategy achievement supplied by Balanced Scorecard.

Business Process Server’s Management module enables its users to perform such Balanced Scorecard management processes as:

- Establishing performance targets, either by using the predefined KPIs discussed above or by using the Balanced Scorecard Designer to create customized KPIs that more accurately reflect your organization’s requirements.
- Integrating with external systems to collect relevant data, and effectively monitoring business processes through standard or customized KPIs.
- Measure the contribution business processes are making in achieving business objectives and strategic goals.

Each of the Balanced Scorecard Perspectives are derived from key performance indicators (KPIs). Each of these KPIs can be assigned a weight that indicates its comparative significance. In the Balance Scorecard console view, each KPI value is displayed as a dial. This dial displays the target score along with the actual score for each KPI. The target score divides the circumference of the dial into two parts; the first part, that is, the arc from 0.0 to target score is shown in red, whereas the second part, that is, the arc from target score to 10.0 is shown in green. The needle of the dial indicates rounded-off actual score. Optionally, the fields below the dial show the exact actual value and/or target score. This dial gives a visual indicator of achievements and help managers to track the progress.

Viewing Balanced Scorecard Applications

Business Process Server contains processes and rules that collate Business Scorecard data and it then inserts this data in infopads. Business Process Server enables you to view this data as a standard Balanced Scorecard application, or to design a customized Balanced Scorecard application.

The user must install the Balanced Scorecard sample application, and then select Balanced Scorecard from the drop-down list on the Balanced Scorecard page to display the standard view. By default, a view of all the perspective values is displayed.

Refer Figure 55 on page 107.
To view your Balanced Scorecard application:

1. In the Management module, click Balanced Scorecard > Console. The Balanced Scorecard page.

Figure 55: Balanced Scorecard Page

2. Select an option from the Balanced Scorecard drop-down list, select an option from the Perspective drop-down list, and then click Go to obtain information on a specific Balanced Scorecard Perspective. Options include All, Customer, Finance, Innovation and Internal.
3. Edit values for each perspective by clicking the **Edit** icon ( ). For more information, see [Editing Balanced Scorecard Perspectives](#) on page 108.

4. In the console view, each KPI value is displayed as a dial. Each dial is associated with a link to infopad analysis reports that launch a history for the selected KPI. For example, clicking the Product Returns dial of the Customer perspective displays the report. Click on any of the KPI links to execute a corresponding analysis report.

**Figure 56: Balanced Scorecard History**

<table>
<thead>
<tr>
<th>No.</th>
<th>Month</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>March 2010</td>
<td>7.58</td>
</tr>
</tbody>
</table>

**Editing Balanced Scorecard Perspectives**

Business Process Server provides a management application interface in which the user can edit the Relative Weights for a specific KPI, as well as modify other values and enter a description of each KPI in the selected perspective.

This interface is seen in **Figure 57** on page 109.

For example, you can emphasize the importance of Profit Margin KPI in the Finance Perspective by increasing the original value of 0.2 (20%) to a value of 0.70 (70%) in the Weight column. Changing the relative weight of the Profit Margin KPI changes the score for the Finance Perspective, as well as the total Balanced Score.

**Note:** The sum of the numbers in the Edit (Perspective) **Relative Weights** dialog window must not exceed 1.0.

Refer **Figure 57** on page 109.
To edit a Balanced Scorecard value:

1. Click the **Edit** icon (displayed to the right of each Perspective (see Figure 57 on page 109) to open the **Perspective Details** page.

**Figure 57: Editing Balanced Scorecard Perspectives**

<table>
<thead>
<tr>
<th>No.</th>
<th>KPI</th>
<th>Weight</th>
<th>Unit</th>
<th>Worst Value</th>
<th>Best Value</th>
<th>Target Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Product Revenues</td>
<td>0.25</td>
<td>dollars</td>
<td>125000</td>
<td>150000</td>
<td>9.5</td>
</tr>
<tr>
<td>02</td>
<td>Service Revenues</td>
<td>0.25</td>
<td>dollars</td>
<td>375000</td>
<td>250000</td>
<td>9.5</td>
</tr>
<tr>
<td>03</td>
<td>Product Revenue Growth</td>
<td>0.05</td>
<td>percent</td>
<td>5</td>
<td>36</td>
<td>9</td>
</tr>
<tr>
<td>04</td>
<td>Service Revenue Growth</td>
<td>0.05</td>
<td>percent</td>
<td>10</td>
<td>45</td>
<td>9</td>
</tr>
</tbody>
</table>

2. Modify the data in any of the boxes.

3. Click **Save** to submit and save your changes. A Confirmation message appears, indicating the editing of the perspective values was successful. Click **OK**, and return to the **Balanced Scorecard** page.

Click **Reset** to delete your changes and display the original settings.

Click **Cancel** to delete your changes and return to the **Balanced Scorecard** page.

**Using the Balanced Scorecard Designer**

Business Process Server provides the Balanced Scorecard Designer, which presents a series of user interfaces where you can view your available Balanced Scorecard applications, modify existing Balanced Scorecards, and add a new Balanced Scorecard application that meets your specific requirements.
Designing a New Balanced Scorecard

To design a new Balanced Scorecard:

1. In the Management module, click **Balanced Scorecard > Designer**, to open the **Balanced Scorecard List** page.

**Figure 58: Balanced Scorecard List Page**

All available Balanced Scorecard applications are listed, with respective status and a brief description for each of them.

The status column indicates the state of the Balanced Scorecard:

- The green icon indicates a valid Balanced Scorecard and it is listed in the **BP Server Applications** page in the Administration module.
• The red icon indicates that the Balance Scorecard is not defined properly or its rules are not compiled. You must resolve these issues to add this in the BP Server Applications page.

2. To add a new Balanced Scorecard, click Add Balanced Scorecard, to open the Add Balanced Scorecard page.

Figure 59: Add Balanced Scorecard Page

![Add Balanced Scorecard Page](image)

a) Enter the name of the new Balanced Scorecard and its description. Both these are required fields.

b) Click Next, to open the Perspectives List page where you can create perspectives for the new Balanced Scorecard.

3. The Perspectives List page enables you to:

   Figure 60: Add Perspective Page
   ![Add Perspective Page](image)

a) Enter a name in the Perspective box and assign the perspective a weight.
Note: The perspective name must not contain spaces.

b) You may add more perspective(s), when required, by clicking Add Perspective, which opens Add Perspective window. Enter perspective and weight and click Save to add the perspective to the Perspective/Weight table.

c) Click Next, to open the Source List page where you can define sources to be used by the KPIs of the new Balanced Scorecard.

4. The Source List page enables you to add sources of information that can be used to define KPIs and generate Balanced Scorecards. All KPIs must have at least one source, and Additive and Averaging KPIs can have multiple sources. This page displays two tables listing the Process Template Sources and the Infopad Sources.

Figure 61: Source List Page

5. Click Add Source to open the Add Source window.

Figure 62: Add Source Page for New KPIs

a) Select an option from the Source Information list. Options include Process Templates or Infopads.

b) Enter the name of the new Source in the Source box.

c) If the Source information comes from a process template, then select options from the Process Template, Workstep, Event and Dataslot lists to further define the source.
**Note:** The Dataslot drop-down list contains INTEGER and CHARACTER type dataslots only.

d) If the Source information comes from an infopad, then specify the Application, Module, Infopad Name, Row, Column and Slot containing the updated value.

**Note:** The Slot drop-down list does not contain the slots of type "CHARACTER".

e) Click **Save** to save the new Source and go back to the **Source List** page to define additional sources. Depending upon whether the source information is specified as process template or infopad, the new source is added in the appropriate table in the **Source List** page.

f) Click **Next**, to open the **KPI List** page where you can define KPIs for the new Balanced Scorecard.

6. The **KPI List** page displays the list of KPI. You can select a perspective from the drop-down list beside Go, and click **Go**, to list KPIs of selected perspective only.

**Figure 63: Add KPI Page**

7. From the **Perspective** drop-down list, select the perspective to which the new KPI is assigned, and click **Add KPI**. The Add KPI window is opened.

a) The KPI Details tab displays the name of the selected balanced scorecard and perspective in read only mode.

b) Enter the name of the KPI.

**Note:** The KPI Name must be unique.

c) Select a KPI type from the Type list. Options include:

- Additive, which updates the current value by adding on any updated values.
- Average, which updates the current value by averaging in any updated values.
- Replace, which replaces the current value with the updated one.
d) Enter values for each of the displayed parameters. Assign a weight -- weight values must be in the 0-1 range. The Current Value and Score are generally used for initialization purposes only. The Best Value and Worst Value are used in calculating the score. Unit is used for summary descriptions; longer descriptions are entered in Description. You can specify the target score between 0.0 and 10.0 for each KPI in the Target Score. The Balanced Scorecard Console displays the target score along with the actual score for each key performance indicator. It gives a visual indicator of achievements and help managers to track the progress.

e) Select the Editable checkbox to enable users to modify the value or the Display checkbox to create a read-only value.

f) Click Attach Source tab. This tab displays the list of available sources defined earlier and the list of sources attached to the KPI.

g) Select one or more available sources from the Select Sources list and click Add to add them in the Attached Sources list. You can click Add All to add all available sources simultaneously. You may use Remove or Remove All to remove the sources from the Attached Sources list and put them back in the Select Sources list.

h) Click Save to save the new KPI and go back to the KPI List page. The new KPI is listed in the table on this page.

8. Click Finish to create the new Balanced Scorecard.

9. A Confirmation message appears, indicating that you have successfully added a new Balanced Scorecard. Click OK to save it and return to the Balanced Scorecard List page.

After you have designed and saved a new Balanced Scorecard, you (or someone like Business Process Server administrator, who has requisite access permissions) must install it as a new application from the Business Process Portal's Administration module for it to work properly.

### Generating Rules in Balanced Scorecards

Balanced Scorecard Designer automatically generates one rule file for each Balanced Scorecard. This rule file contains the following sections.

- **Initialization.** This section creates an infopad containing the weights of the perspectives. The Perspective Weight infopad contains one row for each perspective in the scorecard. The lone slot in the cell provides the weight for that perspective, and each slot has an alarm that is triggered with the weight changes. This event triggers a rule that updates the overall score. Initialization creates a dynamic infopad for the overall score, with one row created for each month. The lone slot in the definition cell provides the score. Initialization also creates a dynamic infopad for each perspective, with one row for each month and one column for each KPI in that perspective. For more information, see Main Scorecard Group Rule.

- **Finalize.** This section contains an entry for each of the infopads created that will destroy them when the rules are unloaded.

The rule file also contains the following rule groups:

- **Update Values.** Updates the current values of the appropriate infopads. The Update Values rule vary depending on the KPI type and the number and type of data sources. If the KPI type is additive, then the Business Process Portal adds the value of the data source to the KPI's current value slot. If the KPI type is averaging, then the Business Process Portal averages the value of the data source to the KPI's current value slot. If the KPI type is replace, then the Business Process Portal action replaces the current value with the value of the data source.

- **Main Scorecard Group.** Contains the escalation rules for calculation, rules that update the infopads when the collection process completes; and a rule that adds a row to all the dynamic
infopads on the last day of a month and schedules the next month's event. Cells in each infopad have an alarm that trigger a different update rule. Rules included in this group include:

- **Perspective BestValue Rule**: Each perspective contains one best value rule, which is triggered when a BestValue slot has changed in a cell. It recalculates the score for the relevant KPI.

- **Perspective WorstValue Rule**: Each perspective contains one worst value rule, which is triggered when a WorstValue slot has changed in a cell. It recalculates the score for the relevant KPI.

- **Perspective currentValue Greater Than Rule**: Each perspective contains one CurrentValue Greater Than rule, which is triggered when a CurrentValue slot has changed, and the NegativeRange for that cell is 'F', meaning that the BestValue is greater than the WorstValue. The rule checks that the CurrentValue is less than BestValue; or it sets BestValue to the CurrentValue and checks that the CurrentValue is greater than WorstValue; or it sets WorstValue to the CurrentValue. It then generates an event that triggers a rule to recalculate the score.

- **Perspective CurrentValue Less Than Rule**: Each perspective contains one CurrentValue Less Than rule, which is triggered when a CurrentValue slot has changed, and the NegativeRange for that cell is 'T', meaning that the BestValue is less than the WorstValue. The rule checks that the CurrentValue is greater than the BestValue; or it sets BestValue to the CurrentValue and checks that the CurrentValue is less than the WorstValue; or it sets WorstValue to the CurrentValue. It then generates an event that triggers a rule to recalculate the score.

- **Perspective CurrentValue Update Rule**: Each perspective contains one CurrentValue Update rule, which is triggered by the event generated by the CurrentValue Greater than rule or the CurrentValue Less than rule. It then recalculates the score of the affected cell.

- **Perspective RelativeWeight Rule**: Each perspective contains one RelativeWeight rule, which is triggered when the relative weight slot has changed in a cell and the affected cell is not in the last row of the infopad. It updates the sum of the weights in the last column. Then it issues an event for each KPI in the perspective that recalculates the score for each cell, triggering the CurrentValue Update rule.

- **Perspective Score Rule**: Each perspective contains one Score rule, which is triggered when the score slot has changed in a cell. It then recalculates the perspective score.

- **Perspective BSCard Rule**: Each perspective contains one BSCard rule, which is triggered when the Perspective score slot has changed. It issues an event that triggers a rule to recalculate the main overall score.

- **Perspective BPServerUpdate Rule**: Each perspective contains one BPServerUpdate rule, which is triggered when the perspective subprocess W_COMPLETED event is sent. It then updates the CurrentValue for every KPI in the perspective.

- **Perspective Weight BSCard Rule**: Each perspective contains one Perspective Weight BSCard rule, which is triggered when the weight for a perspective has been updated. It then triggers a rule to recalculate the main overall score.

- **Overall UpdateMainBSC Rule**: Each perspective contains one UpdateMainBSC rule, which is triggered when perspective weights or scores change. It then updates the main overall score.

- **AddRowsToScorecardInfopads Rule**: Each perspective contains one AddRowsToScorecardInfopads rule, which is triggered when the scheduled event is sent. For each of the dynamic infopads (i.e., each of the perspective infopads and the main
scorecard infopad), a row is added and the values from the previous row are copied into the new row. Finally, an event is scheduled to trigger the rule on the last day of the next month.

Viewing and Modifying Existing Balanced Scorecards

If you modify an existing Balanced Scorecard, to view the changes, then you (or Business Process Server administrator) must reinstall the modified Balanced Scorecard.

To access or modify existing Balanced Scorecard applications:

1. In the Management module, click Balanced Scorecard > Designer, to open the Balanced Scorecard List page, where all existing Balance Scorecards are listed.

Figure 64: Balanced Scorecard List Page

To delete a Balanced Scorecard from those listed on the Balanced Scorecard List page, select a Balanced Scorecard from the list and click Delete.

To copy a Balanced Scorecard and save it as a new Balanced Scorecard, click Save Balanced Scorecard Copy... The copied balanced scorecard is not accessible from the Administration module because its rule file is not yet compiled. To compile it and make it accessible from the Administration module, you need to modify and save the copied balanced scorecard.

2. Click the name of the balanced scorecard in the Balanced Scorecard column to view or modify the corresponding Balanced Scorecard, opening the Add Balanced Scorecard page. Change the name of the new Balanced Scorecard and/or its description.

Refer Figure 59 on page 111.

3. Click Next, to open the Perspectives List page where you can modify perspectives of the Balanced Scorecard.

Refer Figure 60 on page 111.

To delete a Perspective from those listed on the Perspectives List page, select a Perspective from the list and click Delete. You can add new perspectives, and/or edit names/weights of the existing perspectives.

4. Click Next, to open the Source List page where you can modify sources used by the KPIs of a Balanced Scorecard.
To delete a Source from those listed on the **Source List** page, select a Source from the list and click **Delete**. You can add new sources, and/or edit details of the existing sources.

5. Click **Next**, to open the **KPI List** page (see **Figure 63** on page 113) where you can modify KPIs of the Balanced Scorecard.

To delete a KPI from those listed on the **KPI List** page, select a KPI from the list and click **Delete**. You can add new KPIs, and/or edit details of the existing KPI.

6. Click **Finish** to save the current scorecard.
Using the Infopad Manager

An infopad is a table, composed of elements called cells, that store such global data as application parameters (for example, a list of e-mail addresses of persons to notify) or rule parameters (for example, the critical threshold for a resource load). Each cell is a data structure made up of slots, or attributes, that in turn contain slotnames and values. The Infopad Manager enables you to edit the information provided in an infopad.

For details, see the following topics:

- Modifying Infopad Values
- Exporting Infopads

Modifying Infopad Values

To use Infopad Manager to modify infopad values:

1. In the Management module, click Infopads, to view the Infopads page.
2. Select the application from the Application drop-down list, then select the infopad you want to edit from the Infopad drop-down, and click Go. Names of the selected Application and Infopad are displayed below the selection bar.
3. In the case of multidimensional infopads, an infopad cell is located in a specific row and column. Specify whether the infopad is to be sliced on row or column by selecting appropriate option. Depending on this selection, select the row/column from the drop-down list and click Go.
After selecting a cell, the slotnames and their values within that cell appear below.

### Figure 65: Infopads Page

![Infopads Page](image)

4. Edit the values in the cell by changing the values in the text boxes in the Column.
5. Click **Save** to save your changes. Business Process Portal saves your changes after your confirmation.

To reset the form and remove the information you just entered, click **Reset**.

**Note:** For more information on infopads, see the "Infopads" chapter in the *BPM Events User's Guide*.

---

**Exporting Infopads**

You can export business metrics and Balanced Scorecards into different formats for creating reports and documentation.

**To do so, follow these steps:**

1. In the Management module, click **Infopads**, to view the **Infopads** page.
2. Select the application from the **Application** drop-down list, then select the infopad you want to edit from the **Infopad** drop-down, and click **Go**.
3. Select the format in which you want to export this data from the **Export Type** drop-down list. You can choose one of the HTML, XML or XLS formats. Click **Export**.

Business Process Portal displays the infopads and their values in the specified format.
Predefined Reports

Business Process Server enables you to run a series of predefined reports that are based on selections you make from the following criteria:

- **Report type.** In the submenu options under the Reports menu, choose from the Status Analysis, Time Analysis or Workload Analysis report types. The Time Analysis option, for example, enables you to run a report based on time factors.
- **Analysis type.** In the Analysis for: drop-down list, select whether you want to execute a report based on Instance, Performer or Workstep.
- **Application type.** In the Applications drop-down list, select All to run a report for all installed applications, or select a specific application.

**Note:** You can select the All option in Application drop-down list in out of the box Jasper Report. In bpmportal.conf file, set bpmportal.report.allapplications parameter to false. The default value is true. If there is no installed application, then the All option is displayed irrespective of bpmportal.report.allapplications parameter configuration.

- **Subcriteria** based on Report type.
  - When you select a Status Analysis report type, and analyze it for an Instance or Performer, a Status drop-down list is displayed that contains the following Status options: All, Active, Completed, Removed and Suspended, whereas when you analyze it for a Workstep, the Status drop-down list contains the following Status options: All, Active, Completed and Suspended. In the Date drop-down list, select a predefined interval (for example, All, Today, This Week, Last Month, etc.) or enter Start and End dates in the From: and To: boxes, respectively.
  - If you select a Time Analysis report type, then the Time Analysis drop-down list is displayed that contains the following options: Completion Time (time of actual or estimated completion), Elapsed Time (the interval between start and current time—when a workstep is not yet
completed and not overdue), Overdue Time (the amount of delay from the scheduled end
time up to the current time for a workstep which is not yet completed and is overdue) and
Estimated vs Elapsed Time. In the Date drop-down list, select a predefined interval (for
example, All, Today, This Week, Last Month, etc.) or enter Start and End dates in the From:
and To: boxes, respectively.

• If you select a Workload Analysis report type, then a Workload Type drop-down list is
displayed that contains the following options: Today’s Tasks (i.e., all tasks due the present
day and overdue) or Due Today.

**Note:** While filtering based on the date, only the starting date is considered.

For details, see the following topics:

- Creating Status Analysis Reports
- Creating Time Analysis Reports
- Creating Workload Analysis reports

## Creating Status Analysis Reports

To create a status analysis report that shows the total instances for each status (Active, Completed,
Suspended, Removed) for the Assign_A_Task_V1 application.

**Perform the following:**

1. In the Management module, click **Reports > Status Analysis**, to view the **Status Analysis**
page.
2. Select:
   
   - **Instance** from the Analysis for: drop-down list.
   - **Assign_A_Task_V1** from the Applications list.
   - **All** from the Status list.
   - **None** from the Subprocess list.
   
   You can analyze for Instance, Performer or Workstep.

3. Specify the name of the creator in the **Creator** text box. Alternatively, click the Search User
icon, and then select the creator from the displayed window.

4. Select a predefined interval from the Date drop-down list (for example, All, Today, This Week,
Last Month, etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click
the Select Date icon ( ) to facilitate entering a date.
5. Click Go, and the report appears in the workspace.

![Figure 66: Status Analysis Report for All Instances for Assign_A_Task_V1 Application](image)

6. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.

7. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list.

**Note:** If you select HTML, then the report mail is sent as an HTML formatted email. If your mail-tool supports mails in HTML format, then you can view the HTML report in your mail-tool. But if your mail-tool supports mails only in text format, then you cannot view the HTML report.

![Figure 67: Email Report Dialog Box](image)

8. Click Submit to email the report.

To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Creating status of completed worksteps

To create a report that shows the status of all completed worksteps for the Assign_A_Task_V1 application.

Perform the following:

1. In the Management module, click Reports > Status Analysis, to view the Status Analysis page.

2. Select:
   - Workstep from the Analysis for: drop-down list.
   - Assign_A_Task_V1 from the Applications list.
   - Completed from the Status list.
   - None from the Subprocess list.

3. Specify the name of the performer in the Performer text box. Alternatively, click the Search User icon, and then select the performer from the displayed window.

4. Select a predefined interval from the Date drop-down list (for example, Today, This Week, Last Month, etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date icon ( ) to facilitate entering a date.

5. Click Go, and the report appears in the workspace.

6. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.

7. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list. Refer Figure 67 on page 123.

8. Click Submit to email the report.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Creating Time Analysis Reports

To create a time analysis report that shows the completion time for all instances of all applications:

1. In the Management module, click Reports > Time Analysis, to view the Time Analysis page.
2. Select:
   - **Instance** from the Analysis for: drop-down list.
   - **All** from the Applications list.
   - **Completion Time** from the Analysis Time list.
3. Specify the name of the creator in the Creator text box. Alternatively, click the Search User icon, and then select the creator from the displayed window.
4. Select a predefined interval from the Date drop-down list (for example, All, Today, This Week, Last Month, etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date icon ( ) to facilitate entering a date.
5. Click Go, and the report appears in the workspace.

**Figure 69: Time Analysis Report for Completion Time of Instances for All Application**

6. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.
7. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list.
   Refer Figure 67 on page 123.
8. Click Submit to email the report.
   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Creating Elasped time report

To create a report that shows the elapsed time (i.e., the interval between start and current time—when a workstep is not yet completed and not overdue) for all active worksteps of all applications.

Perform the following:

1. In the Management module, click Reports > Time Analysis, to view the Time Analysis page.
2. Select:
   - Workstep from the Analysis for: drop-down list.
   - All from the Applications list.
   - Elapsed Time from the Analysis Time list.
3. Specify the name of the performer in the Performer text box. Alternatively, click the Search User icon, and then select the performer from the displayed window.
4. Select a predefined interval from the Date drop-down list (for example, All, Today, This Week, Last Month, etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date icon ( ) to facilitate entering a date.
5. Click Go, and the report appears in the workspace.

   Figure 70: Time Analysis Report for Elapsed Time for All Application Worksteps

6. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.
7. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list.

    Refer Figure 67 on page 123.
8. Click Submit to email the report.

    To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Creating Workload Analysis reports

To create a workload analysis report that lists all instances of all applications that are overdue or due on the current day:

1. In the Management module, click Reports > Workload Analysis, to view the Workload Analysis page.
2. Select:
   - Instance from the Analysis for: drop-down list.
   - All from the Applications list.
   - Today’s Tasks from the Workload Type list.
3. Specify the name of the creator in the Creator text box. Alternatively, click the Search User icon, and then select the creator from the displayed window.
4. Click Go, and the report appears in the workspace.

Figure 71: Workload Analysis Report for All Due or Overdue Application Instances

5. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.
6. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list.
   Refer Figure 67 on page 123.
7. Click Submit to email the report.

To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Creating workload analysis report for a specific task

To create a workload analysis report that lists all performers that are responsible for tasks for the Assign_A_Task_V1 application that are due on the current day:

1. In the Management module, click Reports > Workload Analysis, to view the Workload Analysis page.

2. Select:
   - Performer from the Analysis for: drop-down list.
   - Approval from the Applications list.
   - Due Today from the Workload Type list.

3. Specify the name of the performer in the Performer text box. Alternatively, click the Search User icon, and then select the performer from the displayed window.

4. Click Go, and the report appears in the workspace.

   Figure 72: Workload Analysis Report for All Performers with Tasks Due in Assign_A_Task_V1

5. Select the preferred format from the Report Format drop-down list and click View to view the report in a specific format.

6. Click Email... to open the Email Report dialog box. Enter information in the relevant boxes and select a format from the Report Format drop-down list.

   Refer Figure 67 on page 123.

7. Click Submit to email the report.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current dialog box, click Close.
Third-party acknowledgments

One or more products in the Progress OpenEdge v11.3 release includes third party components covered by licenses that require that the following documentation notices be provided:
Progress OpenEdge v11.3 may incorporate ANT v1.5.4. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1, applies to all versions of up to ant 1.6.0 included. The Apache Software License, Version 1.1 - Copyright (C) 2000-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.
4. The names "Ant" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.
5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.
Progress OpenEdge v11.3 may incorporate Apache Avalon 2002/08/06, Apache Batik v1.1, Apache Jakarta POI v1.1, Apache POI 2003/05/14, Regexp (Pure Java Regular Expression) v1.2, and XMLTask v1.15.1 from The Apache Software Foundation. Such technologies are subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 2000 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: “This product includes software developed by the Apache Software Foundation (http://www.apache.org/).” Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.
4. The names “Apache” and “Apache Software Foundation” must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.
5. Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>. Portions of this software are based upon public domain software originally written at the National Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.
Progress OpenEdge v11.3 may incorporate Apache JAXP v1.3.04 from The Apache Software Foundation. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xalan" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED \""AS IS\" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, Lotus Development Corporation., http://www.lotus.com. For more information on the Apache Software Foundation, please see http://www.apache.org/.
Progress OpenEdge v11.3 may incorporate Crimson v1.1.3 from Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

Progress OpenEdge v11.3 may incorporate jfor v0.7.2 from jfor. Such technology is subject to the following terms and conditions: jfor Apache-Style Software License. Copyright (c) 2002 by the jfor project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the jfor project (http://www.jfor.org)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The name "jfor" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact info@jfor.org. 5. Products derived from this software may not be called "jfor", nor may "jfor" appear in their name, without prior written permission of info@jfor.org. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Apache LogKit v1.2 from The Apache Software Foundation. Such technologies are subject to the following terms and conditions: The Apache Software License, Version 1.1 -- Copyright (C) 1997-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "LogKit", "Jakarta" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.
Progress OpenEdge v11.3 may incorporate Xerces for Java XML Parser v2.6.2. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate SOAP v2.3.1 from Apache Foundation. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1

Copyright (c) 1999 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "SOAP" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.
Appendix A: Third-party acknowledgments

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate ANTLR (Another Tool for Language Recognition) v2.7.6. Such technology is subject to the following terms and conditions: ANTLR 3 License [The BSD License] Copyright (c) 2003-2006, Terence Parr All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Castor v0.9.3 from castor.org. Such technology is subject to the following terms and conditions: Original Intalio license - Copyright 1999-2004 (C) Intalio Inc., and others. All Rights Reserved. Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name "ExoLab" must not be used to endorse or promote products derived from this Software without prior written permission of Intalio Inc. For written permission, please contact info@exolab.org. 4. Products derived from this Software may not be called "Castor" nor may "Castor" appear in their names without prior written permission of Intalio Inc. Exolab, Castor and Intalio are trademarks of Intalio Inc. 5. Due credit should be given to the ExoLab Project (http://www.exolab.org/). THIS SOFTWARE IS PROVIDED BY INTALIO AND CONTRIBUTORS "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTALIO OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Decimal Conversion Code (dtoa.c; g_fmt.c; rnd_prod.s; decstrd.c; decstrtof.c; dmisc.c; gdtoa.c; gdtoa.h; gdtoaimp.h; gethex.c; gmisc.c; hd_init.c; misc.c; smisc.c; strtodg.c; strtord.c; sum.c; ulp.c). Such technologies are subject to the following terms and conditions: dtoa.c License: The author of this software is David M. Gay. Copyright (c) 1991, 2000, 2001 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. g_fmt.c License: The author of this software is David M. Gay. Copyright (c) 1991, 1996 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
Appendix A: Third-party acknowledgments

rnd_prods License: The author of this software is David M. Gay. Copyright (c) 1991 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

decstrtd.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

decstrtof.c License: The author of this software is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

dmisc.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

gdtos.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gdtoa.h License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gdtoaimp.h License: The author of this software is David M. Gay. Copyright (C) 1998-2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gethex.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gmisc.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. hd_init.c License: The author of this software is David M. Gay. Copyright (C) 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. misc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. smisc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. strtodg.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The author of this software is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate DOM4J v1.6.1 from MetaStuff, Ltd. Such technology is subject to the following terms and conditions: Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved. Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name "DOM4J" must not be used to endorse or promote products derived from this Software without prior written permission of MetaStuff, Ltd. For written permission, please contact dom4j-info@metastuff.com. 4. Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark of MetaStuff, Ltd. 5. Due credit should be given to the DOM4J Project - http://www.dom4j.org THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GraphicsMagick v1.3.14 from GraphicsMagick Group. Such technology is subject to the following terms and conditions:

.. This text is in reStucturedText format, so it may look a bit odd. .. See http://docutils.sourceforge.net/rst.html for details.

======================================
GraphicsMagick Copyrights and Licenses
======================================

This file is part of the GraphicsMagick software distributed by the GraphicsMagick Group.

["Please note that the legal community considers 15 or more total lines of code or text (not necessarily contiguous) to be significant for the purposes of copyright. Repeated changes such as renaming a symbol has similar significance to changing one line of code.*]"

The licenses which components of this software fall under are as follows.

1) In November 2002, the GraphicsMagick Group created GraphicsMagick from ImageMagick Studio's ImageMagick and applied the "MIT" style license: Copyright (C) 2002 - 2012 GraphicsMagick Group
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject
to the following conditions: The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS",
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
to the WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

2) In October 1999, ImageMagick Studio assumed the responsibility for the development of
ImageMagick (forking from the distribution by E. I. du Pont de Nemours and Company) and applied
a new license:

Copyright (C) 2002 ImageMagick Studio, a non-profit organization dedicated to making software
imaging solutions freely available.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction,
including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
ImageMagick, and to permit persons to whom the ImageMagick is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of ImageMagick.

The software is provided "as is", without warranty of any kind, express or implied, including but
not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall ImageMagick Studio be liable for any claim, damages or other liability, whether in
an action of contract, tort or otherwise, arising from, out of or in connection with ImageMagick
or the use or other dealings in ImageMagick.

Except as contained in this notice, the name of the ImageMagick Studio shall not be used in
advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior
written authorization from the ImageMagick Studio.

3) From 1991 to October 1999 (through ImageMagick 4.2.9), ImageMagick was developed and
distributed by E. I. du Pont de Nemours and Company: Copyright 1999 E. I. du Pont de Nemours
and Company

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of ImageMagick, and to permit persons to whom the ImageMagick is furnished
to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of ImageMagick.

The software is provided "as is", without warranty of any kind, express or implied, including but
not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall E. I. du Pont de Nemours and Company be liable for any claim, damages or other
liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with
ImageMagick or the use or other dealings in ImageMagick.
Except as contained in this notice, the name of the E. I. du Pont de Nemours and Company shall not be used in advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior written authorization from the E. I. du Pont de Nemours and Company.

4) The GraphicsMagick Base64Decode() and Base64Encode() functions are based on source code obtained from OpenSSH. This source code is distributed under the following license: Copyright (c) 2000 Markus Friedl. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR \"AS IS\" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5) Many of the pattern images in coders/logo.c are derived from XFig, which is distributed under the following license:

| FIG : Facility for Interactive Generation of figures
| Copyright (c) 1985-1988 by Supoj Sutanthavibul
| Parts Copyright (c) 1989-2000 by Brian V. Smith
| Parts Copyright (c) 1991 by Paul King

Any party obtaining a copy of these files is granted, free of charge, a full and unrestricted irrevocable, world-wide, paid up, royalty-free, nonexclusive right and license to deal in this software and documentation files (the "Software"), including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons who receive copies from any such party to do so, with the only requirement being that this copyright notice remain intact.

6) The documentation for the composition operators is copied from the rlecomp manual page, which is authored by Rod Bogart and John W. Peterson. Rlecomp is part of the Utah Raster Toolkit distributed by the University of Michigan and the University of Utah. The copyright for this manual page is as follows: Copyright (c) 1986, University of Utah

This software is copyrighted as noted below. It may be freely copied, modified, and redistributed, provided that the copyright notice is preserved on all copies.

There is no warranty or other guarantee of fitness for this software, it is provided solely "as is". Bug reports or fixes may be sent to the author, who may or may not act on them as he desires.

You may not include this software in a program or other software product without supplying the source, or without informing the end-user that the source is available for no extra charge.

If you modify this software, you should include a notice giving the name of the person performing the modification, the date of modification, and the reason for such modification.

7) The source code comprising swab.c is originally derived from libtiff which has the following license:
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

8) The C++ API known as "Magick++", and which resides in the Magick++ directory, is distributed under the following license: Copyright 1999 - 2003 Bob Friesenhahn <bfriesen@simple.dallas.tx.us>

Permission is hereby granted, free of charge, to any person obtaining a copy of the source files and associated documentation files ("Magick++"), to deal in Magick++ without restriction, including without limitation of the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of Magick++, and to permit persons to whom the Magick++ is furnished to do so, subject to the following conditions:

This copyright notice shall be included in all copies or substantial portions of Magick++. The copyright to Magick++ is retained by its author and shall not be subsumed or replaced by any other copyright.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall Bob Friesenhahn be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with Magick++ or the use or other dealings in Magick++.

9) The GraphicsMagick HaldClutImagePixels() function in magick/hclut.c is based on source code from the HaldCLUT package by Eskil Steenberg (http://www.quelsolaar.com/technology/clut.html) which is distributed under the following license: Copyright (c) 2005 Eskil Steenberg. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

10) GraphicsMagick makes use of third-party "delegate" libraries to support certain optional features. These libraries bear their own copyrights and licenses, which may be more or less restrictive than the GraphicsMagick license. For convenience, when GraphicsMagick is bundled with (or compiled with) "delegate" libraries, a copy of the licenses for these libraries is provided in a "licenses" directory.

OVERVIEW and LEGAL ISSUES from jpeg.txt file (from GraphicsMagick):

The Independent JPEG Group's JPEG software

-------------------------------

README for release 6b of 27-Mar-1998

-------------------------------

This distribution contains the sixth public release of the Independent JPEG Group's free JPEG software. You are welcome to redistribute this software and to use it for any purpose, subject to the conditions under LEGAL ISSUES, below. Serious users of this software (particularly those incorporating it into larger programs) should contact IJG at jpeg-info@uunet.uu.net to be added to our electronic mailing list. Mailing list members are notified of updates and have a chance to participate in technical discussions, etc. This software is the work of Tom Lane, Philip Gladstone, Jim Boucher, Lee Crocker, Julian Minguillon, Luis Ortiz, George Phillips, Davide Rossi, Guido Vollbeding, Ge' Weijers, and other members of the Independent JPEG Group. IJG is not affiliated with the official ISO JPEG standards committee. OVERVIEW

This package contains C software to implement JPEG image compression and decompression. JPEG (pronounced "jay-peg") is a standardized compression method for full-color and gray-scale images. JPEG is intended for compressing "real-world" scenes; line drawings, cartoons and other non-realistic images are not its strong suit. JPEG is lossy, meaning that the output image is not exactly identical to the input image. Hence you must not use JPEG if you have to have identical output bits. However, on typical photographic images, very good compression levels can be obtained with no visible change, and remarkably high compression levels are possible if you can tolerate a low-quality image. For more details, see the references, or just experiment with various compression settings. This software implements JPEG baseline, extended-sequential, and progressive compression processes. Provision is made for supporting all variants of these processes, although some uncommon parameter settings aren't implemented yet.

For legal reasons, we are not distributing code for the arithmetic-coding variants of JPEG; see LEGAL ISSUES. We have made no provision for supporting the hierarchical or lossless processes defined in the standard. We provide a set of library routines for reading and writing JPEG image files, plus two sample applications "cjpeg" and "djpeg", which use the library to perform conversion between JPEG and some other popular image file formats. The library is intended to be reused in other applications.
In order to support file conversion and viewing software, we have included considerable functionality beyond the bare JPEG coding/decoding capability; for example, the color quantization modules are not strictly part of JPEG decoding, but they are essential for output to colormapped file formats or colormapped displays. These extra functions can be compiled out of the library if not required for a particular application. We have also included "jpegtran", a utility for lossless transcoding between different JPEG processes, and "rdjpgcom" and "wrjpgcom", two simple applications for inserting and extracting textual comments in JFIF files.

The emphasis in designing this software has been on achieving portability and flexibility, while also making it fast enough to be useful. In particular, the software is not intended to be read as a tutorial on JPEG. (See the REFERENCES section for introductory material.) Rather, it is intended to be reliable, portable, industrial-strength code. We do not claim to have achieved that goal in every aspect of the software, but we strive for it.

We welcome the use of this software as a component of commercial products.

No royalty is required, but we do ask for an acknowledgement in product documentation, as described under LEGAL ISSUES.

LEGAL ISSUES

In plain English:

1. We don't promise that this software works. (But if you find any bugs, please let us know!)
2. You can use this software for whatever you want. You don't have to pay us.
3. You may not pretend that you wrote this software. If you use it in a program, you must acknowledge somewhere in your documentation that you've used the IJG code.

In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, its quality, accuracy, merchantability, or fitness for a particular purpose. This software is provided "AS IS", and you, its user, assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991-1998, Thomas G. Lane.

All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any purpose, without fee, subject to these conditions:

(1) If any part of the source code for this software is distributed, then this README file must be included, with this copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly indicated in accompanying documentation.

(2) If only executable code is distributed, then the accompanying documentation must state that "this software is based in part on the work of the Independent JPEG Group".

(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to this software or products derived from it. This software may be referred to only as "the Independent JPEG Group's software".

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder, Aladdin Enterprises of Menlo Park, CA.
ansi2knr.c is NOT covered by the above copyright and conditions, but instead by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you redistribute it. (See the file ansi2knr.c for full details.) However, since ansi2knr.c is not needed as part of any program generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

The Unix configuration script "configure" was produced with GNU Autoconf.

It is copyright by the Free Software Foundation but is freely distributable.

The same holds for its supporting scripts (config.guess, config.sub, ltconfig, ltmain.sh). Another support script, install-sh, is copyright by M.I.T. but is also freely distributable.

It appears that the arithmetic coding option of the JPEG spec is covered by patents owned by IBM, AT&T, and Mitsubishi. Hence arithmetic coding cannot legally be used without obtaining one or more licenses. For this reason, support for arithmetic coding has been removed from the free JPEG software. (Since arithmetic coding provides only a marginal gain over the unpatented Huffman mode, it is unlikely that very many implementations will support it.)

So far as we are aware, there are no patent restrictions on the remaining code.

The IJG distribution formerly included code to read and write GIF files.

To avoid entanglement with the Unisys LZW patent, GIF reading support has been removed altogether, and the GIF writer has been simplified to produce "un compressed GIFs". This technique does not use the LZW algorithm; the resulting GIF files are larger than usual, but are readable by all standard GIF decoders.

We are required to state that "The Graphics Interchange Format(c) is the Copyright property of CompuServe Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated."

Contents of png.txt file (from GraphicsMagick):

This copy of the libpng notices is provided for your convenience. In case of any discrepancy between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence. libpng versions 1.0.7, July 1, 2000, through 1.2.0, September 1, 2001, are Copyright (c) 2000 Glenn Randers-Pehrson and are distributed according to the same disclaimer and license as libpng-1.0.6 with the following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux
Eric S. Raymond
Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the following individuals added to the list of Contributing Authors:

Tom Lane
Glenn Randers-Pehrson
Willem van Schaik
libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger

Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added to the list of Contributing Authors:

  John Bowler
  Kevin Bracey
  Sam Bushell
  Magnus Holmgren
  Greg Roelofs
  Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc. For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of individuals:

  Andreas Dilger
  Dave Martindale
  Guy Eric Schalnat
  Paul Schmidt
  Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright notice may not be removed or altered from any source or altered source distribution. The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this source code as a component to supporting the PNG file format in commercial products. If you use this source code in a product, acknowledgment is not required but would be appreciated.

A "png_get_copyright" function is available, for convenient use in "about" boxes and the like:

printf("%s", png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a certification mark of the Open Source Initiative.

  Glenn Randers-Pehrson
  randeg@alum.rpi.edu
  September 1, 2001
Appendix A: Third-party acknowledgments

Contents of tiff.txt file (from GraphicsMagick):

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,

EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Contents of zlib.txt file (from GraphicsMagick):

zlib 1.1.3 is a general purpose data compression library. All the code is thread safe. The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format). These documents are also available in other formats from ftp://ftp.uu.net/graphics/png/documents/zlib/zdoc-index.html

All functions of the compression library are documented in the file zlib.h (volunteer to write man pages welcome, contact jloup@gzip.org). A usage example of the library is given in the file example.c which also tests that the library is working correctly. Another example is given in the file minigzip.c. The compression library itself is composed of all source files except example.c and minigzip.c.

To compile all files and run the test program, follow the instructions given at the top of Makefile. In short "make test; make install" should work for most machines. For Unix: "configure; make test; make install"

For MSDOS, use one of the special makefiles such as Makefile.msc.

For VMS, use Make_vms.com or descrip.mms.

Questions about zlib should be sent to <zlib@quest.jpl.nasa.gov>, or to Gilles Vollant <info@winimage.com> for the Windows DLL version.

The zlib home page is http://www.cdrom.com/pub/infozip/zlib/

The official zlib ftp site is ftp://ftp.cdrom.com/pub/infozip/zlib/

Before reporting a problem, please check those sites to verify that you have the latest version of zlib; otherwise get the latest version and check whether the problem still exists or not.

Mark Nelson <markn@tiny.com> wrote an article about zlib for the Jan. 1997 issue of Dr. Dobb's Journal; a copy of the article is available in http://web2.airmail.net/markn/articles/zlibtool/zlibtool.htm

The changes made in version 1.1.3 are documented in the file ChangeLog.

The main changes since 1.1.2 are:

- fix "an inflate input buffer bug that shows up on rare but persistent occasions" (Mark)
- fix gzread and gztell for concatenated .gz files (Didier Le Botlan)
- fix gzseek(..., SEEK_SET) in write mode
- fix crc check after a gzeek (Frank Faubert)
- fix miniunzip when the last entry in a zip file is itself a zip file

(J Lilge)
- add contrib/asm586 and contrib/asm686 (Brian Raiter)
See http://www.muppetlabs.com/~breadbox/software/assembly.html
- add support for Delphi 3 in contrib/delphi (Bob Dellaca)
- add support for C++Builder 3 and Delphi 3 in contrib/delphi2 (Davide Moretti)
- do not exit prematurely in untgz if 0 at start of block (Magnus Holmgren)
- use macro EXTERN instead of extern to support DLL for BeOS (Sander Stoks)
- added a FAQ file

plus many changes for portability.

Unsupported third party contributions are provided in directory "contrib". A Java implementation of zlib is available in the Java Development Kit 1.1 http://www.javasoft.com/products/JDK/1.1/docs/api/Package-java.util.zip.html

See the zlib home page http://www.cdrom.com/pub/infozip/zlib/ for details.

A Perl interface to zlib written by Paul Marquess <p_marquess@bfsec.bt.co.uk> is in the CPAN (Comprehensive Perl Archive Network) sites, such as: ftp://ftp.cis.ufl.edu/pub/perl/CPAN/modules/by-module/Compress/Compress-Zlib*

A Python interface to zlib written by A.M. Kuchling <amk@magnet.com> is available in Python 1.5 and later versions, see http://www.python.org/doc/lib/module-zlib.html

A zlib binding for TCL written by Andreas Kupries >a.kupries@westend.com> is available at http://www.westend.com/~kupries/doc/trf/man/man.html

An experimental package to read and write files in .zip format, written on top of zlib by Gilles Vollant >info@winimage.com>, is available at http://www.winimage.com/zLibDll/unzip.html and also in the contrib/minizip directory of zlib.

Notes for some targets:
- To build a Windows DLL version, include in a DLL project zlib.def, zlib.rc and all .c files except example.c and minigzip.c; compile with -DZLIB_DLL

The zlib DLL support was initially done by Alessandro Iacopetti and is now maintained by Gilles Vollant <info@winimage.com>. Check the zlib DLL home page at http://www.winimage.com/zLibDll

From Visual Basic, you can call the DLL functions which do not take a structure as argument: compress, uncompress and all gz* functions.

See contrib/visual-basic.txt for more information, or get http://www.tcfb.com/dowseware/cmp-z-it.zip

- For 64-bit Irix, deflate.c must be compiled without any optimization. With -O, one libpng test fails. The test works in 32 bit mode (with the -n32 compiler flag). The compiler bug has been reported to SGI.

- zlib doesn't work with gcc 2.6.3 on a DEC 3000/300LX under OSF/1 2.1 it works when compiled with cc.

- on Digital Unix 4.0D (formerly OSF/1) on AlphaServer, the cc option -std1 is necessary to get gzprintf working correctly. This is done by configure.
- zlib doesn't work on HP-UX 9.05 with some versions of /bin/cc. It works with other compilers. Use "make test" to check your compiler.

- gzdopen is not supported on RISCOS, BEOS and by some Mac compilers.

- For Turbo C the small model is supported only with reduced performance to avoid any far allocation; it was tested with -DMAX_WBITS=11 -DMAX_MEM_LEVEL=3

- For PalmOs, see http://www.cs.uit.no/~perm/PASTA/pilot/software.html Per Harald Myrvang <perm@stud.cs.uit.no> Acknowledgments:

The deflate format used by zlib was defined by Phil Katz. The deflate and zlib specifications were written by L. Peter Deutsch. Thanks to all the people who reported problems and suggested various improvements in zlib; they are too numerous to cite here.

Copyright notice:

(C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

If you use the zlib library in a product, we would appreciate *not* receiving lengthy legal documents to sign. The sources are provided for free but without warranty of any kind. The library has been entirely written by Jean-loup Gailly and Mark Adler; it does not include third-party code.

If you redistribute modified sources, we would appreciate that you include in the file ChangeLog history information documenting your changes.
Progress OpenEdge v11.3 may incorporate International Classes for Unicode (International Components for Unicode) v2.4 from IBM. Such technology is subject to the following terms and conditions:

ICU License - The ICU project is licensed under the X License (see also the x.org original), which is compatible with GPL but non-copyleft. The license allows ICU to be incorporated into a wide variety of software projects using the GPL license. The X license is compatible with the GPL, while also allowing ICU to be incorporated into non-open source products. License ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective owners.

Progress OpenEdge v11.3 may incorporate International Components for Unicode v4.8.0. Such technology is subject to the following terms and conditions:

ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2011 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective owners.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate java.net args4j v2.0.12 from Kohsuke Kawaguchi. Such technology is subject to the following terms and conditions: Copyright (c) 2003, Kohsuke Kawaguchi All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: * Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Jaxen v1.1-beta-3 from jaxen.org. Such technology is subject to the following terms and conditions: Project License |id: LICENSE.txt 1128 2006-02-05 21:49:04Z elharo | Copyright 2003-2006 The Werken Company. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Jaxen Project nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Jing 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Jing Copying Conditions. Copyright (c) 2001-2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Third-party JARs - This distribution includes some additional JAR files, which have their own copying conditions:

saxon.jar Comes from the Saxon 6.5.2 distribution and is covered by these conditions xercesImpl.jar
xml-apis.jar Come from the Xerces-J 2.4.0 distribution and are covered by the Apache Software License isorelax.jar Comes from ISO RELAX 2003/01/08 distribution and is covered by the following license: Copyright (c) 2001-2002, SourceForge ISO-RELAX Project (ASAMI Tomoharu, Daisuke Okajima, Kohsuke Kawaguchi, and MURATA Makoto) Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate Sun's Jmaki framework v1.0 and Sun's Jmaki framework v1.0.3 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions:

Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Jmaki framework v1.8.0 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions: Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: * Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. * Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.
Progress OpenEdge v11.3 may incorporate JSTL v1.0 from Sun Microsystems, Inc. Such technologies are subject to the following terms and conditions: Code sample License Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Looks v2.1.2 from JGoodies. Such technology is subject to the following terms and conditions: The BSD License for the JGoodies Looks - Copyright (c) 2001-2007 JGoodies Karsten Lentzsch. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate OpenSSL v0.9.8 from The OpenSSL Project. Such technology is subject to the following terms and conditions: OpenSS License. Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)."
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)." THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenSSL includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Original SSLeay License. Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer, the list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)." The word ‘cryptographic’ can be left out if the routines from the library being used are not cryptographic related :-). 4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgment: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)." THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. The licence and distribution terms for any publicly available version or derivative of this code cannot be changed, i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

Progress OpenEdge v11.3 may incorporate Quartz Enterprise Job Scheduler v1.3.2 from James House. Such technologies are subject to the following terms and conditions: Copyright James House (c) 2001-2003 All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ``AS IS“ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION). HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This product uses and includes within its distribution, software developed by the Apache Software Foundation (http://www.apache.org/).

Progress OpenEdge v11.3 may incorporate relaxngDatatype.jar portion of Progress Extensions for Eclipse v2.2. Such technology is subject to the following terms and conditions: Copyright (c) 2001, Thai Open Source Software Center Ltd, Sun Microsystems. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the names of the copyright holders nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate SLF4J v1.6.2 and SLF4J Log4J v1.6.1 from sfl4j.org. Such technology is subject to the following terms and conditions: Copyright (c) 2004-2008 QOS.ch All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Progress OpenEdge v11.3 may incorporate STAX API (JSR 173) v3.1.1 from Woodstox Project. Such technology is subject to the following terms and conditions: Copyright (c) 2004-2010, Woodstox Project (http://woodstox.codehaus.org/) All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of the Woodstox XML Processor nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Trang 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Copyright (c) 2002, 2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate xpp3-1.1.3.4.O portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Indiana University Extreme! Lab Software License Version 1.1.1 Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment:

"This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Indiana Univeristy" and "Indiana Univeristy Extreme! Lab" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/.

5. Products derived from this software may not use "Indiana Univeristy" name nor may "Indiana Univeristy" appear in their name, without prior written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Xpp3 v1.1.3.4 from Indiana University. Such technology is subject to the following terms and conditions: Indiana University Extreme! Lab Software License Version 1.1.1 Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Indiana Univeristy" and "Indiana Univeristy Extreme! Lab" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/. 5. Products derived from this software may not use "Indiana Univeristy" name nor may "Indiana Univeristy" appear in their name, without prior written permission of the Indiana University. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate XStream v1.3.1 from XStream. Such technology is subject to the following terms and conditions: Copyright (c) 2003-2006, Joe Walnes Copyright (c) 2006-2007, XStream Committers All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of XStream nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate YAJL v0.4.0 from Lloyd Hilaiel. Such technology is subject to the following terms and conditions: Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GNU ZLIB v1.1.4 and GNU ZLIB v1.2.3 from Jean-loup Gailiy & Mark Alder. Such technology is subject to the following terms and conditions: Copyright notice: (C) 1995-2002 Jean-loup Gailly and Mark Adler This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software. Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions: 1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required. 2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software. 3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

Progress OpenEdge v11.3 may incorporate ZLIB.NET Free v1.0.4 from ComponentAce. Such technology is subject to the following terms and conditions: Copyright (c) 2006-2007, ComponentAce http://www.componentace.com All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of ComponentAce nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate LALR Parser Generator in Java v0.10k. Such technology is subject to the following terms and conditions: CUP Parser Generator Copyright Notice, License, and Disclaimer – Copyright 1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian - Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the names of the authors or their employers not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. The authors and their employers disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall the authors or their employers be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action, arising out of or in connection with the use or performance of this software.

Progress OpenEdge v11.3 includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. (MD5 Encryption Library v3.0 and MD5 Encryption vMD5C.C) These technologies are subject to the following terms and conditions: RSA Data Security MD5 message-digest algorithm RSA Data Security, Inc. MD5C.C - RSA Data Security, Inc., MD5 message-digest algorithm Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. License to copy and use this software is granted provided that it is identified as the "RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing this software or this function. License is also granted to make and use derivative works provided that such works are identified as "derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing the derived work. RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or the suitability of this software for any particular purpose. It is provided "as is" without express or implied warranty of any kind. These notices must be retained in any copies of any part of this documentation and/or software.
Glossary

This is a listing of common Business Process Server terminology. For a full version of terms used in Business Process Server documentation, refer to the *OpenEdge Business Process Server: Terminology Guide*.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ACL manager</strong></td>
<td>In Business Process Server, Access Control List Manager provides a finer, more precise control over user access rights for resources and actions.</td>
</tr>
<tr>
<td><strong>Activity workstep</strong></td>
<td>In Business Process, the basic unit of work; must be performed by one or more human performers (valid individual user, multiple users or user group).</td>
</tr>
<tr>
<td><strong>Adapter</strong></td>
<td>A Java class that integrates remote, third party classes and actions with Business Process. An adapter can automate certain functions and tasks performed by a remote server or other external systems.</td>
</tr>
<tr>
<td><strong>Administration</strong></td>
<td>A module in Business Process Portal enabling the administrator to perform tasks such as installing/uninstalling applications, modifying configuration parameters controlling Business Process operations, and manage users, groups and access control. The Administration module is visible only to application users who have permissions to access it.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>In Business Process, an application is an installed, executable business process that automates a business flow.</td>
</tr>
<tr>
<td><strong>Balanced scorecard</strong></td>
<td>A management application in the Management module that measures performance by analyzing how an organization’s business activities help it achieve its strategic goals. The Balanced Scorecard provides an analysis from a range of perspectives.</td>
</tr>
<tr>
<td><strong>BAM</strong></td>
<td>Business Activity Management combines Business process management with strategic and analytical information on specific business performance indicators, providing real-time status information and identifying critical events to assist senior management in making informed business decisions.</td>
</tr>
<tr>
<td><strong>BP Server</strong></td>
<td>A Business Process Server component that provides a flexible, lightweight, scalable workflow process engine for intranets, extranets, and the Internet.</td>
</tr>
<tr>
<td><strong>BPM Events</strong></td>
<td>A Business Process Server component that provides an open event-driven rule engine to formulate and enforce policies in business applications.</td>
</tr>
<tr>
<td><strong>BPM Workflow</strong></td>
<td>A Business Process Server component that enables users to develop customizable, sophisticated presentation flows for business processes, install them as Web applications, and execute them on their Web browsers.</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>BPEL</strong></td>
<td>BPEL (Business Process Execution Language) for Web services is an XML-based language designed to enable task-sharing for a distributed computing or grid computing environment - including across multiple organizations - using a combination of Web services.</td>
</tr>
<tr>
<td><strong>BPMN</strong></td>
<td>BPMN (Business Process Modelling Notation) provides businesses with the capability of defining and understanding their internal and external business procedures through a Business Process Diagram giving organizations the ability to communicate these procedures in a standard manner.</td>
</tr>
<tr>
<td><strong>Business Process Portal</strong></td>
<td>A Business Process Server component that offers users, managers, administrators and developers a unified, customizable portal for single sign-on access to all Business Process Server functionalities to which they are granted permission.</td>
</tr>
<tr>
<td><strong>Progress Developer Studio for OpenEdge</strong></td>
<td>An Integrated Development Environment for Business Process Server that enables application users to develop and publish a Business Process Server application without leaving the development environment.</td>
</tr>
<tr>
<td><strong>Business calendar</strong></td>
<td>A Business Process Server feature that accurately calculates the Due Date of tasks, and provides support for multiple business calendars across different time zones.</td>
</tr>
<tr>
<td><strong>Business flow</strong></td>
<td>The logical sequence of process activities, related to one another by a triggering activity, to achieve an outcome. It represents a business process that begins with a commitment and ends with the termination of that commitment. In Business Process Server, business flow includes workflow (the flow of all human-performed activities), integration flow (the flow of activities performed by systems) and presentation flow (from a user’s viewpoint, the flow of data from one Web page to the next).</td>
</tr>
<tr>
<td><strong>Business logic</strong></td>
<td>The control flow and information flow among worksteps that define a business process.</td>
</tr>
<tr>
<td><strong>Business Process Server application</strong></td>
<td>An application is an implementation of a business process. It can contain one or more process templates, performers, adapters, customized forms or rules. An application can be published, installed and run on BP Servers. In Business Process Server, an application is an installed, executable business process that automates a workflow.</td>
</tr>
<tr>
<td><strong>Business Process Server Web services</strong></td>
<td>A Business Process Server component that allows application developers to; a) publish their applications as Web services, and b) find and convert other available Web services on the Internet into Business Process Server applications.</td>
</tr>
<tr>
<td><strong>Business object</strong></td>
<td>A representation of an activity in the business domain, including its name, definition, attributes, behavior, relationships and constraints.</td>
</tr>
<tr>
<td><strong>Business process</strong></td>
<td>A process involving multiple worksteps in the form of operations, interactions and notifications performed by a user, group of users, an external adapter, or a script.</td>
</tr>
<tr>
<td><strong>Business process management</strong></td>
<td>The concept of guiding work activities through a multi-step business process in order to improve performance and reduce costs within and across functional business units.</td>
</tr>
</tbody>
</table>
**Business rule**
A combination of elements, including validation edits, logon verifications, database lookups, policies and transformations, that represent an enterprise's way of doing business.

**Control flow**
The sequences of worksteps and workstep conditions, as defined in a process template in Progress Developer Studio for OpenEdge or Business Process Modeler.

**Dashboard**
A Business Process Server feature that provides a graphic overview of the status of several business processes on a single Web page, enabling users to monitor the progress of each process. Users can view business processes across all applications or for a selected application.

**Dataslot**
A data placeholder that persists through the entire process and defines the information flow of the business process. Dataslots are associated with processes, where they can add information into (Input type) or out of (Output type) worksteps, and appear as editable or read-only fields on a user's interface.

**Expression editor**
A Business Process Server tool that enables users to define complex conditional expressions within a Decision gateway to support their business requirements.

**Group**
In Business Process Server, an entity that has as members valid users or other groups who perform related work and have authorized access to specific components.

**Heatmap**
A Business Process Server feature that provides a convenient, graphical tool for managers to visually locate the bottlenecks in the process execution. It helps managers to get an overview of the status of the currently active instances, identify suspended instances, and analyze the history of the completed instances.

**Home**
A module in Business Process Portal through which users interact with Business Process Server. Using the Home module, users complete entries to various tasks and applications, update profile, set preferences, and link to the support infrastructure required to achieve these tasks. The Home module is the primary interface for application users.

**Infopad**
In Business Process Server, a data structure used to capture business metrics, typically displayed as a table with one or two dimensions.

**Instance**
An individual object within a specific class. In Business Process Server, a self-contained unit that is created each time you use a process template to run a Business Process Server application.

**KPI**
Key Performance Indicator, used in the Balanced Scorecard system, that provides the data translating enterprise goals into a set of measurable objectives.

**Management**
A module in Business Process Portal enabling the managers to query, report, and control processes and resources for application users. The Management module is visible only to application users who have permissions to access it.

**Managed adapter**
In Business Process Server, a Managed Adapter is an implementation of an adapter interface that facilitates data exchange between Business Process Server processes and external applications.

**Migration**
The process of moving from the use of one operating environment to another operating environment that is typically seen as improvement. Migration can involve moving to new hardware, new software, or both. It may involve a
new application, another type of database, or a redesigned network. Migration is also used to refer simply to the process of moving data from one storage device to another. Business Process Server supports data migration as well as application migration.

**Performer**
An entity that executes a workstep. Depending on the workstep type, the performer can be a human user, a group of users, an adapter or other external performer, or a script.

**Presentation flow**
The flow of information and user input from one interface to the next. Typically related to a single Activity workstep in the process and generated in a BPM Workflow environment.

**Process engine**
Orchestrates the execution of business processes and also coordinates conversations among process engines based on public processes, which forms the backbone of global business collaboration.

**Business Process Modeler**
A stand-alone component that enables users to design templates for basic business processes.

**Process refresh**
A Business Process Server feature for replacing the installed process without versioning, facilitating the running process instances to refresh and seamlessly adapt to the new workflow.

**Process template**
In Business Process Server, a model of business flow that includes worksteps, connectors and dataslots. After users publish and install it as an application in Business Process Server folder structure, they can use the application to create process instances.

**Rollback**
In Business Process Server, a feature that restarts the workflow from a workstep previously selected as the rollback point in the process, performed automatically in the event of a failure.

**Role**
The actions and activities assigned to a valid application user who is a member of a group. In Business Process Server, only members of a group can be assigned a role. A role indicates the relationships of the user in a group context.

**Rule wizard**
An interactive utility that enables application users to quickly develop rules that can be applied to a business process.

**Swim lanes**
Used in workflow diagrams to organize complex processes across functional boundaries. For example, seen as horizontal lines on a process map, swim lanes can be used to place individual task steps into different categories that depend on task ownership.

**Task**
In Business Process Server, a performer is assigned one or more work items that the performer sees as tasks. There are two types of tasks: Assigned, which are assigned specifically to you; and Available, which are available to be performed by you or other members of your user group.

**User**
In Business Process Server, a valid human performer with authorized access to specific modules.

**Workflow**
The logical sequence of activities performed by human performers. Workflow includes the tasks, procedural steps, organizations or people involved, required input and output information, and tools needed for each activity in a business process.